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1. Elysium InfiPoints Overview

1.1. What InfiPoints Can Do

InfiPoints is a software to effectively utilize laser scanned 3D point clouds. InfiPoints supports
simulation, modeling and data pre-processing of point clouds, capable of reducing time and
labor for operation.

1.1.1. InfiPoints Application Examples

Check Situations of Actual Sites on Your Computer

Avoid the haste of going on-site to manually measure dimensions. InfiPoints allows
smooth rendering and editing of large-scale point cloud data. You can check the condition
of the site and make measurements accurately and effortlessly on your computer.

&, =

Automatically Register Point Cloud Data

InfiPoints enables automatic registration of multiple scans.

3D laser scanning requires scanning from multiple angles and locations, and aligning
them into a single data file. With automatic registration, users can substantially reduce
time for manual alignment.
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Digitally Simulate Equipment Emplacement Routes

Simulate emplacement routes for installing new equipment on-site.
Using both CAD models and point clouds, InfiPoints enables interference check among
walls, ceilings, and objects such as existing equipment.

Automatic Modeling of Pipes and Equipment

No manual work is needed to model individual pipes and equipment.
You can automatically extract pipes and planes from point clouds and create CAD models
easily.

Export 2D Working Drawings

2D working drawings can be created easily from scanned point cloud data.
2D drawings can be exported and shared with construction managers as soon as the data
is pre-processed. Measurements do not have to be taken on-site anymore.

Point Working
Cloud Drawing
(3D) (2D)
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Create Movies

Create high quality movies from scanned point clouds.
Traveling costs for site visits can be reduced, and timely decisions can be made on-site.

Point Fly-through
(3D)
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1.2. Frequently Asked Questions for Data Pre-
Processing

1.2.1. FAQ
Question Answer
No response since Please be aware that depending on the size of the point cloud data, it
the execution can take a very long time to complete the process. (In some cases, it

began. What should | .4y, take up to half a day for a single process to complete.)

Ido? Elysium is continuously enhancing the software for better
performance, and therefore it is very important to keep the software
up to date. Please contact Elysium customer support if there is no
response for more than 20 hours.

Please refer to 1.7.1, “Guide for Processing Time” for an estimated
time of execution using the sample data.

"Auto Registration" | The point cloud data may lack the necessary information to execute
or "Noise the process. These processes will not work with data in text and ".pts"
Reduction" fails? format.
However, they will work fine with raw data from 3D scanning such
as, ".fls" files. Please note that some information could get lost from
raw data if edited in other applications.

It takes too long for | Noise reduction is parallel processed which tends to cause high
the noise reduction? | memory usage. It could take time if the process consumes more
memory than is available.
Memory consumption could be reduced by changing the parallel
processing settings:

* Decrease the value of [Number of used threads] at [System
Preference] > [Miscellaneous].

* Please ensure that "the specified value (number of threads to use)
X 8GB" is below the memory size.

8GB is the recommended memory size for 40 million
' points or less per shot of a point cloud data. When
— many points exist per shot, InfiPoints may consume
more memory than 8GB.

*Please refer to 1.5.1, “Selecting number of threads used (Option)” for
information about the number of threads.
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1.3. Contact Us

Please contact us for any inquiries.

Elysium Co. Ltd. Customer Support
Tel: +81-53-413-1006
Email: infipoints@elysium.co.jp

1.4. Process Flow

When processing point cloud data, users can first import multiple shots into the software and
then align the data to create a single point cloud data file.
Removing unnecessary noise could optimize work efficiency and improve the accuracy as well.

This is called "data pre-processing."

M Importing the original scanned data directly into InfiPoints

@ Elysium InfiPoints.

Scanner
Data Noise Export/
mm) > tmport o . .
w Registration Reduction Planning
I Dat
dala .
Import Data Pre-processing

InfiPoints can import various data formats (i.e., .fls, .zfs, .ptx) created by other point cloud
processing software such as FARO SCENE, Laser Control, Cyclone, etc.

Export in “fls” or
“ptx” etc.

| Importing data processed in other software J

Scanner Other point cloud handling software

|
e
: Data ’
Create File
I- - Registration

II\

@ Elysium InfiPoints.
Optimize Noise Export/
Import _ . i i
Registration Reduction Planning
Data .
Data Pre-processing
Import
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1.5. Machine Setup

1.5.1. Selecting number of threads used (Option)

By selecting the number of threads (parallel processing) used, it is possible to shorten the
processing time for data import, plane and pipe extraction, and/or noise reduction.

Setting limitations differ with each machine environment, but it is preferable to configure this
setting as soon as possible for optimal performance.

i

Selecting the same number of threads as physical threads is recommended.

* [Application Menu] > [Option] > [System Preference] > [Miscellaneous]

-| ) © ~ Smart Filter *|  FInfiPoints

T,
‘ New System Preference...

|

2 ELYSIUM © 2023 Elysium

System Preferences ' ﬁ Open Project... [;_'—"i'g Display Preference..
Path -
Cuick Access Toolbar H Save.. D 3\ Import/Export Setti
BackGround Color 1 g MPOrLEKPOTL SELTS. .
Axis
Ground plane Clean up Project A Change Language 3
Ruler/Grid
Rotation Center H Print... N @ License Setting...
View operaticn
View operation(2)
CAD/Polygon Madel k.
Cloud Function
IMisceIIaneous I( B Ewit
Foint Cloud File [T Add information Tor sha
Length units m v
H Number of used threads 2 v I
Use functions under develapment LoN
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1.5.2. Maximizing rendering capability (Option)

In the default setting, point clouds are thinned out for view operations to achieve high-speed
rendering.

It is possible to display all point clouds without thinning, but this may slow down point cloud
rendering time in some cases.

* [Application Menu] > [Option] > [Display Preference] > [Tessellation Tol]

Display Setting

i Point Cloud
Paint cloud shader Draw using point cloud shaderrendering whe
rawing

Annotation Density of display {num./pixel)

Dimension

Deviation Point Size {times)
Point Cloud Point Type Size-adjusted (Round) ~
Plane/Piping Elerfent

CAD/Peolygon Mddel Depth for perspective view

Reference Point Close-up m [ 5et Automatically
Reld of View degreels) | M

Drawing method durina the view operation
() Prioritize speed

; () Prioritize detailed

(®) Auto

-
"Priortize detailed” when poirts to display

On some machines that have video cards such as RADEON installed, point
clouds may be displayed while panning, but disappear once you stop.

Go to [Application Menu] > [Option] > [System Preference] and switch off
[Reduce flicker during point cloud display] to avoid this problem.

Viewing delays
of some shots
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1.6. Notes on Registration of Point Cloud Data

1.6.1. Points to be noted when scanning with 3D laser scanner

InfiPoints can automatically register point clouds without placing markers or target spheres

during scanning.

Please refer below for tips on how to register point clouds without using markers.

Registration without Markers

Merits of registration without markers

InfiPoints automatically determines the location of the shots by referring to neighboring
shots in a relative manner. For this reason, InfiPoints does not require markers for

registration. Also, it is not necessary to relocate markers when rescanning sites. This can
reduce time and cost of placing markers.

Time and cost of
marker placement is
unnecessary

Relocation of markers are
not necessary for re-
scanning of same sites

Points to be considered when not using markers

Labor
saving of
scanning

Relatively aligned shots have small alignment errors within the scanner tolerances.
Accumulation of small alignhment errors when scanning large scale can cause precision
error that may exceed the scanning tolerances.

* Accumulation of alignment errors without marker registration.

Ideal registration
result

2 ELYSIUM © 2023 Elysium

Without marker registration data result.
Slight differences between neighboring
scans might add up exceeding the

tolerance in large scale multi-scan data.
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Scanning Methods in Strict Tolerance Situations
Placement of markers and use of survey instruments

Use of surveying instruments to locate marker coordinates can be helpful to meet strict
tolerance requirements with large scale structures and long piping, for example.
InfiPoints can import marker coordinates of shots and define their absolute location.

» Registration using marker coordinates

P11

P11

P3  pg
Use surveying instruments to locate Using marker coordinates (x,y,z), place each
marker coordinates along with the scan on absolute coordinate space
360 degree laser scanner
/]\
Create similar tolerance 3D data as traditional
surveying
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1.6.2. Marker placement effectiveness in defining global coordinate
systems

It is highly effective to place markers at the time of scan to obtain accurate global coordinates
when registering.

It is necessary, however, to maintain distance between markers. Markers placed too close can
cause errors.

Points to be Considered When Placing Markers for Global
Coordinate Definition

(Ex) Defining absolute coordinates (X,y,z values) using markers near the origin

=
== : Actual
Ly Site

(Horizontal cross-section ﬂ Point
of building) Cloud

Slight differences within the scanning tolerance
occur near the marker
(i.e. 1-3mm/0.1-0.2 degrees)

L’ Error tends to be bigger farther from the
marker (i.e. 20-100mm)

‘-‘_‘—'—‘—-_
Placing markers far from the origin could

avoid substantial errors

L =l

#2 ELYSIUM © 2023 Elysium Page 10 | 137



Elysium InfiPoints Operation Manual Vol.1. Data Pre-processing

1.7. Before Using InfiPoints

1.7.1. Guide for Processing Time
Please refer below for an estimated time guide of data pre-processing.

In this example, it took 36 min to import 8 scans with 300 million points, and perform
registration, and noise reduction.

Conditions
® Data

» Scan: Indoors (Air conditioning facility)
» Scanner: FARO/Focus3D

* Data Size: 300 Million Points (Total), 40 million points X 8 scans
® Processing Environment

¢ 0S: Windows 10 64bit

CPU: Intel Core i7-8700 (3.2 GHz)

RAM: 32GB

Drive: SSD

e Number of threads: 4

m Sample Data
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Processing Time Details

) Elysium InfiPoints.

Project File . . Noise > Export
. Registration . .
Creation Reduction /Planning
[11min] [2min] [23min] [Total 36 min]
Auto: 30min
Manual: 6min

Data Import: 10min Auto Registration: Tmin Plane/Pipe Extraction: Tmin
(3min per 100 million points) | Fit All: Tmin Defining Origin: Tmin
Save File: Tmin Automatic Noise Reduction: 21min

Elysium InfiPoints is basically designed to process scan shots with a resolution
of 10 to 40 million points per shot. Though it is possible to process scan shots
with the resolution of more than 40 million points per shot, the processing

ﬂ time will take longer and consume a large amount of memory in that case.
Unless there is a need to use high resolution point cloud, such as the interval
between scan shots are very wide, it is recommended that you use the point
cloud data scanned with a resolution setting of 40 million points or less.
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1.7.2. Import/Export File Formats
InfiPoints supports various file formats.

* List of supported file formats

Standard Package

Key Features

Data Registration

MNoise Reduction

Feature Extraction FTh

Point Cloud Grauping LAS

Ground Extraction
Measurement

* Collision Detection ‘ —

Verification against CAD Model

Polygon Generation Eas

Point Cloud Editing DWG

Pipe Modeling IFC

Steel Structure Modeling ENF

ENF Equipment Modeling
Duct Modeling

\ Ortho Image Export

Miate et b
D y Data Export

ata Import ;

FLS/FWS ZFS/ZFPRJ

n
-
un

m
-1

X

=

CEm
=4 4 E
d 17 E

VRML STEP

STEP

=1 [y,
> [
- [

DWG

(=)
x
n

EYEpoints

Visualization File Export
Video Creation
CAD Data Import / Export
Data Size Reduction
Annotation Creation
External Reference

Data Import (Option) Data Export (Option)

CATIA Vi CATIA W5

ACISISAT)

[
=1

ACIS[ISAT)

———
{_Option
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2. View Operation

2.1. User Interface (UI)

Below is the UI of InfiPoints.

| Smart Filter > FnfiPoints - — [m] Y
Home Impart Pre.process Analysis Modeling  Output Creatio Recent Learn with Tutorial = =
— r . -
Measure Volume . = -
Fit  Change - @ -0 -~ (] C - ) Create Create  Edit Create Edit  Show/ Hide
View - Dimension @ Measure Angle Note~ Hote  Zone~ Zone Fanels
View Operation Display Status Display Method Measure Note Zone
=
Tree a g Top View -3 x |

Overviere Pipe  Plane  Structure  Duct
8 Model - g Ribbon

Tree Panel
Fit Update ]
Tree [ Top View | M t
Layer L x| Front View Ll « |
p
jio] Name Mo, of points Colorl  *
o General
EA1  Moise
k2  Ground -
B3 ..
kA4 - |-
4s =[- v
- ’ 3D View Window
ShowjHide WaLL Vo
Selectable ALL o i It
Ready status
Ribbon Displays useful icons for operation.
3D View Window Canvas to display point clouds and CAD models
Tree Panel Displays imported point cloud and related data (hidden in the

screen shot above)

Use the [Show/Hide Panels] in the [Home] tab to show and hide panels (1= ).
The layout of the UI can be easily customized as explained below.

1. Drag the upper part of the panel while left-clicking the mouse.

Learn with Tutorial ~ | P T
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An icon to fix the panel will appear on each side of the screen.

~ |Smart Filter % InfiPoints -

n Home Impart

[j Ry rEEECENEE

Fit  Change |, S EET i o

Pre-process Analysis

View =

View Operation Display Status

Tree
Overviewe Pipe  Plane  Structure * | *
& Model

Icon to fix the panel
on the left

Icon to fix the panel
on the bottom

Ready

+
o8

Modeling  Output Creatic  MMS  [ENG:adachi##  Recent

= m] =
Learn with Tutorial = ?
Icon to fix the panel |, <> ¢
on the top =
TN r Zone
=g

Front View

Icon to fix the panel
on the right

Icon to fix on the
upper right column
(upper arrow)

Icon to fix on the
upper right column
(upper arrow)

2. Fix the position of a panel at the desired location by moving the cursor onto the icon.

(Ex.) Fixing the [Top View] panel at the top right column

1. Left-click at the upper part of the [Top] panel

2. Drag the panel to the icon (Area to be fixed will be highlighted blue)

3. Release left click

- m} x
Learn with Tutorial = ?
ume | (=) [_4 = |
- J = s ¥ A
e L Lo —_— -
Create  Edit Create Edit Show / Hide
Motew Motz | Zone+ Zone Panels *

Hote Zone
Top View -0 = |

2 ELYSIUM © 2023 Elysium

- m} 4
Learn with Tutorial = ?
ume |_ [_4 = o
- ] - LI ]
ale 3 7 —_— -
Create  Edit Create Edit Show / Hide
Mote= Mote | Zone= Zome Panels =
Hote Zone
Top View L x |

Panel is fixed

Front View L x |
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2.2. View Operation

2.2.1. Viewing Mode
There are three viewing modes in InfiPoints.

* Normal Mode: 3D display / Move the view
* Fly-through Mode: 3D display / Move the viewpoint
 Section Mode: 2D display / View section from the front, or Clipping Box from the top/front

o Pressing [Enable/Disable Fly-through View] ( ﬁ“ﬁh ) on the upper right corner of "3D
View" window will switch to fly-through mode.

Fly-through speed can be changed using the [Display Speed Control]

Q button( 1.50 Em ).

o When "Section Mode" is enabled in either [Section] panel or [Clipping] panel, the mode
will switch to Section Mode.
Section |
AR EIN I AREE
iepointsoubsideseeipr [] Section Mode |

[ Display the section Use Curve
Highlight points Auto-align to Z-axis
Display area
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Mode Functionality Type Switching Icon
Default Mode Movement by moving the | Ortho Mode (7
model
Perspective Mode 7
Fly-through View Movement by moving the | Perspective Mode "J,f
Mode viewpoint only
Section Mode Switch to 2D front view of | - -
the selected section
2.2.2. Mouse Operation
Operations below can be performed in the 3D View Window.
Function Functionality Default Mode & Fly-through Section Mode
Name Mode
Rotate 3D Rotate the view by SN\ SN\ -
moving the mouse 99“ 99“
(Screen (Screen
center) center)
Rotate 2D Z Rotate model two .;:.e.:; - -
dimensionally .
(window top)
Rotate 2D Y Rotate model crosswise .;:.e.:; - -
(window
bottom)
Rotate 2D X Rotate model endwise - -

v

(window side)

Zoom in/out

Zoom the view with the
mouse movement

(Zoom will move forward
and backward without
changing the vertical
direction height)

G863

G863

G863

Pan

Move model parallel

{528

{528

{528

Fix Rotation
Center

Set the rotational center

[Ctrl]+ e

[Ctrl]+ e

[Ctrl]+ e

Pick

S

S

S

¥ ELYSIUM © 2023 Elysium
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Function Functionality Default Mode @ Fly-through Section Mode
Name Mode
Pick Area 9 9 9
[Ctrl]+ [Ctrl]+
Q Select [Application Button] > [System Preference] > [View operation] to
configure view operations other than the above.
System Preferences *
Path Select Software Standard ~
Quick Access Toolbar
BackGround Color Pick Additional (O Left Mouse Button @) [Cirl] + Left Mouse Button
Axis View Operation Instruction
Ground Flane Rotation Left Mouse Button + drag
Ruler/Grid
Rotation Center Parallel move  Right Mouse Button + drag
U= °perat?°" Zoom Mouse Wheel
View operation(2) Middle Mouse Button + drag
CAD/Polygon Model Left Mouse Button + Right Mouse Button + drag
Cloud Function
Miscellaneous Rotation Type
® Type A O TypeB
o al B |o
B @ (0| @ |e
2 al B |

The rotation method varies depending on the mouse position
in the graphics window. Choose the rotation type you prefer.

Canca =

m Default Mode / Fly-through Mode

* Pan/Zoom direction can be changed in [Default Mode] and [Fly-through Mode].

| 43 : ~ Smart Filter = ElnfiPo

Home Import Pre-process Analysis

Fit Changell| <#=| Along View Direction

Wiew ' "
«k: Along World Coordinates
View Ope L
d"’ Along View Direction Pan/zoom "Along View Direction”
¥
Be -
=~ Along World Pan/zoom "Along World Coordinates"
Coordinates

* Move with handle
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> Press [Show/Hide Handle for View Operation] ( «%» ) at the upper right of "3D View"
window.

Display Method D
Top

When "Along View Direction" is active

N
Pan up

Zoom in
4 Panleft S Pan rightp

Zoom out

Pan down
v

When "Along World Coordinates" is active

Y
Pan up

Zoom in
e,

Pan left Pan right

v

Zoom out

Pan down
v

» Set Rotation Center
o Specify the rotation center in "3D View" window.

o Press [Fix Rotation Center] ( &) ) at the upper right of "3D View" window.
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Display Method

Fix (Fix at Selected Element) ([Ctrl] + Right-click)
"  Auto (Auto-set Rotation Center)

Viewpoint (Set at Viewpoint)

.
‘3’ Fix (Fix at Selected Element)

) _ Set the selected object at the rotation center
([Ctr]] + Right-click)

Automatically set the rotation center at the center

O -
Auto (Auto-set Rotation Center) area of the 3D View Window

@' Viewpoint (Set at Viewpoint) Set rotation center at viewpoint

m Section mode

Function Overview Section mode
P Zoom Move forward / backward at | Drag the mouse while holding down both L +
the same height R buttons; drag the mouse cursor downward

to zoom in, and upward to zoom out.
-4- Pan Pan left / right / up / down Drag the mouse while holding down R

button.

* Purple bar is displayed at the top of "3D View" window when you are in
Section Mode.

Section Mode

» Please note that 3D rotation is not available in Section Mode.

2.2.3. View operation in 2D layout View
Below shows some useful functions to utilize [Top View] / [Front View] panels.
* Display Range

Move the light blue lines dragging handles on the right to control the view range in [Top
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View] / [Front View] panel. This is effective when registering shots by moving/rotating shots
in [Top View] / [Front View] panel.

| Fit | | Update | & |

o The display range of [Top View] / [Front View] panel will be updated as you move the
blue lines.

> Move blue lines in [Top View] panel to adjust the display range of [Front View] panel,
and blue lines in [Front View] panel to adjust [Top View] panel.

* View Operation
Move the mouse wheel forward / backward in [Top View] / [Front View] panel to zoom in /
out the 2D layout image. And drag while holding down the right-mouse button to pan (move
the 2D layout image parallel).

* View Point
Select [Move Here] from the context menu to move the view point to where you clicked.

Move Here

Show eyesight point of view

Set field of view color..

Rt | Update | | & |

* An arrow in [Top View] panel shows the view point, and the sector shows the field of view,
and the yellow points show the scanner position.
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3. Create Project Data

3.1. Importing 3D Scanned Data

Import 3D laser scanned data and point cloud data created in other software into InfiPoints.

Types of Point Cloud File

» With Elysium InfiPoints, it is recommended that you use point cloud files with scan

index data (*1).

(*1) At Elysium, "Scan index data" refers to the measurement position of the scanned

data, and the array information of the point cloud.

 For point cloud files that do not have scan index data, InfiPoints cannot perform auto
registration or noise removal.

« Below are the formats of Point Cloud data that contains scan index data.

o

fls (FARO)

o

zfs (Z+F)

o

ptx (Leica, etc.)

o

dp (Dot Product)

o

E57 (*2)

(*2) Whether or not the E57 has scan index data depends on the software you used for

pre-processing.

» After importing a point cloud file into InfiPoints, the imported point cloud file will
appear on the structure tree in [Tree (Overview)] panel. For the point cloud file with
scan index data, a plus mark ( & ) is displayed next to each point cloud part under the
"Scans" folder in [Tree (Overview)] panel.

2 ELYSIUM © 2023 Elysium

Tree

Overview  Pipe

Plane Structure  Duct

E--E Model
=8 %

o
Eg{o Eg{o Eg{o Eg{o Eg{o Eg{o Eg{o Eg{o

N

FARO Scan_175.fls
FARO Scan_176.fls
FARO Scan_177.fls
FARO Scan_178.fls
FARO Scan_179.fls
FARO Scan_180.fls
FARO Scan_181.fls
FARO Scan_182.fls
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1. Press [Import] tab > [Point Cloud] (-{iju ) from the ribbon menu.

| 43 = = Smart Filter - EinfiPo

Home

Import Pre-process Analysis

Point
Cloud

% = Merge Project Files

D Polygon 2D0/3D
Model Model Drawing
Data Import

2. Import dialog will appear. Specify the file extension and select point cloud data files to
import. (e.g., "*fls" for FARO 3D scanners)

& Import X
TI <« InfiPoints * sample w | @ I Search Sample 0
Organize ~ Mew folder ==~ [H 9
MNarme Date modified Type Size
7 Quick access
D FARQ Scan_175.fls 2013/11/22 16:25 FLS File 2 KB
& OneDrive [ ] FARO_Scan_176.fls 2013/11/22 1627 FLS File 2 KB
E This PC D FARO Scan_177.fls 2013/11/22 1621 FLS File 2KB
| ] FARO_Scan_17&.fls 2013/11/2216:16  FLS File 2KB
¥ Network [ ] FARO_Scan_179.fls 2013/11/22 1617 FLSFile 2KB
[7] FARD_Scan_180.fls 2013/11/22 1618 FLS File 2KB
| '] FARO_Scan_181.fls 2013/11/22 1619 FLS File 2KB
[ Import by folder [ Save Path
e | FARO_Scan_181.fls" "FARO_Scan_1v | FLS File(*fls, ~fus, *Isproj) |l
: Text File(*.txt, *.asc,*xyz)
Options EST File(*.e57)

ZF5 File(* zfs,* zfprj)
CL3 File(*.cl3)

PTX File(*.ptx)

PTS File(*.pts)
LAS/LAZ File(* las,* laz)
DotProduct File(*.dp)

o Multiple files can be selected by holding the [Shift] key or the [Ctr]] key.

o Point cloud data can be imported by drag-and-drop as well.

o In "Import" dialog, enable "Import by folder" to switch to the folder

v

selection dialog.

[ Import by folder [+] Save Path
Folder: | "FARO_428.f1s" "FARO_429.fIs"
Options | | Select Folder | | Cancel

[—

3. Click [Options] in "Import" dialog.
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Save Path

R FLS File(* fls,* .fws,*.Isproj) -

Options Open |v Cancel

Import/Export Settings dialog will appear.
Users can also choose to automatically extract planes and pipes while importing the point

cloud.

Import/Export Settings

Import FLS File

Colorization [(Execute

Auto filter Enable auto filker
[Jremove outliers

1. Extract features per scan

Plane, pipe, and reference sphere Setting
[J checker board Setting
2, Auto-register scan shots Setting

Run the followings when registered to a single group only

[] 3. align all shots Setting

[ 4. remove noise Setting

5. Merge all possible plane /piping elements
Classify plane groups by area size

Load Defaults Save Defaults

Cancel
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You can configure import/export options for the file type corresponding to

the specified file extension.

Import/Export Settings

Colorization

Auto filter

[remove c

Options are also configurable from [Application Menu] > [Option] >

[Import/Export Settings].

o v smart Filter -

& InfiPoints -

-lq“

T,
MNew

— Open Project...

e

lﬂ Save..

Clean up Project
't
H Print...

| i% Option

System Preference...

[n_“ojl\ Display Preference.
e

1
4 }ﬁ Import/Export Settings...

@ License Setting...

E3 Exit

4. Click [OK] in the file settings dialog.

5. Click [Open] in "Import" dialog. "Setting the Project Folder" dialog will appear.

v

Setting the Project Folder

Set the new project folder.
Please decide a folder name.

Falder Name | |

Browse

OK Cancel

x

Please refer to 3.2, “Saving Projects” for the settings of Project folders.
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3.2. Saving Projects

InfiPoints work data is saved as project file.

1. In "Setting the Project Folder" dialog, set the project folder (Work folder) name and click
[OK].

Setting the Project Folder

Set the new project folder.
Please dedde a folder name.

Folder Name

sample_Praoject|

Br

o]

owse Cancel

o Click [Browse] to select the folder that will be used to save project files.

Please dedde a folder name.,

Folder Name | I

Browse

oK

o The save location which appears when you click [Browse] can be set in
[Application Menu] > [Option] > [System Preference] > [Path].

-| 0% %+ Smart Filter v SInfiPoints
B, ™
‘ Hew %‘ system Preference... |N
Y . =
/] Open froject... [_._Eu_\ﬁ Display Preference...
ks | B
ave.. ‘& Import/Export Settings...
. )
x Clean fip Project A Change Language »

“ Print...

4 @ License Setting...

% Option ]

E Exit

v

System Preferences

Path

Quick Access Todlbar
BackGround Colgr
Axis

Ground plane
Ruler/Grid
Rotation Center
View operation
View operation(
CAD/Polygon M
Cleud Function
Miscellaneous

|
Open | | Browse...
Save | | Browse...
Impart | | Browse...
Bxpott | | Browse...
Work D InfiPoints\Work Browse...

Data

DvInfiPoints\Work_Data Browse...
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Project folder will be created in the Data folder.

All the project data such as drawings and 3D objects which will be created in the later
process will be saved in the project folder as well as imported point cloud data.

I = | om - O X
Home Share View v o
&« R «InfiPoints Project » Sample_Project » Ny J Search 001 el
Name Date modified Type Size
» gk Quick access
CadModel File folder
> 4@ OneDrive CadValidation File folder
> E This PC Drawing File folder
Layoutlmage File folder
» ¥ Network Log File folder
Motion File folder
PointCloud File folder
PointCloudimage File folder
Revision File folder
Scene File folder
Symbol File folder
@ Top.ifproj IFPROI File 516 KB
D Top.ifproj~ IFPROIJ~ File TKB
P Top.ifprojx IFPROJX File 18 KB
14 items =

[Work] or [Data] directories cannot be set in root folders such as C:\ or D:\.

' [Data] folder cannot be set within the [Work] folder. Also, [Work] folder cannot
be set within the [Data] folder.
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Updating Projects in Former Format

Projects saved in InfiPoints Ver.4.1.4 or former cannot be opened in Ver.5.0 or later as
they are. You need to migrate the projects from the former format to the new format.

Please note that you can no longer open updated projects in InfiPoints
‘ Ver.4.1.4 or former. So it is recommended to create a backup before you
—_ start updating the project in case you may need to work in InfiPoints
Ver.4.1.4 or former as well.

1. On the left list of "Open Project File" dialog, specify the project folder created in
InfiPoints 4.1.4 or former, and click [Update] on the right.

Open Project File *

Select a project folder, Select a revision.
| C:\UnfPoints\001

#--Jb Downloads . This project is formatted in a former version. Please dick [Update] below
: i X to update to the new version.

-~ 41 Music

-{&=| Pictures

m Videos
5 Floppy Disk Drive (A:)

.

o "Open Project File" dialog can be displayed by clicking [Open Project]
(27)

Click [Yes] in the following dialog to start migration to the new format project file.

InfiPaoints

Please note that the updated project will not be downward
compatible,
[You will no longer be able to apen it in former version of
InfiPaints.)

Click [Yes] to continue, or [Mo] to create a backup before
updating,

2. The revision list will appear in the right pane once the update is complete.

Open Project File *
Select a project folder, Select a revision.
| C:\InfiPoints\002 Rev. Graph Date Created Comments

- . - 5 & 12/5/2018 5:29:59PM  L.auto.ifproj
i Music 4 & 12/5/2018 4:42:09 PM 0.import.ifproj
=1 Pictures 3 L] 1252018 4:40:13FPM 16F_mod_denoise.ifpro;
B videos 2
2 Floppy Disk Drive (A:) 1
= Local Disk (C:)
TrfiPrints

o 12/5/2018 4:28:39PM  16F_mod.ifproj
o 4/27/2016 6:46:23PM  16F.ifproj
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4. Registration

4.1. Registration

When scanning from multiple locations, it was originally customary to place target markers
beforehand and use them for point cloud registration. When registering with InfiPoints, it is
possible to perform the registration without the target markers. When target markers are used,
there are also functions to use the information for registration.

4.1.1. Registration Using InfiPoints

What is Registration?

Registration of point cloud refers to the relative alignment of 3D scans taken from
multiple locations.

Q "Registration"” is also referred to as "alignment."

—
—
—

m

About Target Marker

InfiPoints is capable of registering 3D point clouds with or without target markers
(picture below on the right) or surveyed coordinates.
Registration methods are explained below.

Q 3D coordinate information acquired from devices such as Total Station,
independent from 3D laser scanner.
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With/Without Markers & Registration Methods

Marker @ Survey | Registration Merit Demerit
Method
Yes Yes Method 1: Minimize Working time
Using surveyed | measurement would be
coordinates error against longer as
the real object surveying is
(within the needed,
survey equipment
tolerance) needed
No Method 2: Short on-site Measurement
Relative work time as error could add
alignment + survey would up with
No - Defining not have to be multiscan
coordinates done registration
Method 1 Method 2

.

; % Markers could be used
P11 for relative registration

P18

It is recommended to use markers (reference spheres / checker board)
0 when laser-scanning landform to improve the registration accuracy.

(Registration using extracted planes is often not available for this kind of

scanned data because they do not contain sufficient planer shapes.)
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Registration Using InfiPoints

 Selecting the Optimal Registration Workflow

Placed a target marker at the

time of 3D laser scanning

Yes

No

|

}

target marker

Surveyed the location of the

Many planar surfaces could be
found in the scanned object
(mainly indoors)

Yes

No

Yes No

Case A

Case B

Case C Case D

» Workflow Cases

With Target Marker

Marker coordinates
available

P1

P10

P2 1005

P3 1620

0 2432 1350 - )
Marker coordinates unavailable

0 1203

0 202

Without Target Marker

Many planar surfaces (indoors)

- |

Less planar surfaces, e.g., natural object
(outdoors)
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* Operation Flow in Each Case

Operation Flow in Case A

2. Initial
Registration

1. Preparation

1. Targetrecognition 5, Automatic registration
(internal reference (could skip)
point)

7. Fit all
(Automatic)

6. Rough manual

2. Import surveyed registration (if registration

external coordinates 1S incomplete)

3. Apply external
coordinates

4. Fix the scan location
with the applied
external coordinates

Operation Flow in Case B

2. Initial
Registration

1. Preparation

8. Accuracy
verification (planes,
targets and surveyed
coordinates)

9. Export registration
result as report

5. Fit all
(Automatic)

1. Target recognition 3. Automatic registration
(internal reference  Use targets (sphere,

point) checker board)
6. Define
4. Rough manual coordinates
registration (if registration

is incomplete)

2. Fix specific scan
data (option)

Operation Flow in Case C

2. Initial
Registration

1. Preparation

7. Accuracy
verification (planes,
targets)

8. Export registration
result as report

3. Automatic registration  5_Fjt al|
(use planes) (Automatic)

1. Create internal
reference point for

registration (option)
4, Rough manual 6. Define

registration (if registration ¢oordinates

2. Fix specific scan e
isincomplete)

data (option)

Operation Flow in Case D

2. Initial
Registration

1. Preparation

7. Accuracy verification
(planes)

8. Export registration
result as report

1. Createinternal 3. Rough manual registration 4. Fitall

reference point for - Parallel shift selecting two (Automatic)
registration (option) points )
- Parallel and rotation 5. Define

2. Fix specific scan movementalongthe silhouette coordinates

data (option)

6. Accuracy
verification (planes)

7. Export registration
result as report
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4.2. Start Registration

1. Press [Pre-process] tab > [Register] > [Start Registration] ( #@} ) from the ribbon menu.

. ) ~ Smart Filter +  FInfiPoints -
l

Home Import Pre-process Analysis Mode

E:*_[“‘] iy Mowve Poirg Cloud Create |
=7 .

e B Polygon Model | & Export
Define the
Registrationl| origin~=

Register

Scanned data are displayed overlapping each other on the "3D View"
window initially.

2. "Start Registration" dialog will appear. Select the options and click [Start].

Start Registration *

Specify scan registration settings, and then click [Start].

Are you registering scans which have already been registered in another
application, e.g., one from a scanner vendor?
Oes ® No

E|y3| um = Select [Yes] to maintain the registration result and refine the registration
accuracy only, or [Mo] to run an initial registration regardless.
- -
InfiPoints.

Was scanning conducted using target markers such

as spheres and checkerboards? \ . i
® Yes I No [

[l Use advanced settings
Use coordinates from a total station
[ Fix the position of scan(s) as a standard

[ Enable editing of internal reference points

Cancel

After selecting [Start], the [Registration] panel and the [Target] panel will appear.
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Registration x|
IU-SBtUp 1.Register 2.Align Ref Point [E)(T]I
Additional information to use in registfation

# | Fix/Unfix Scan Position

¥ Manage Internal Reference Points

'S | Import External Reference Point (CSV)

S B
o | A 5= x 4 Unit : m
valid  MName - Type: Shot name Distance from scan Angle to
1 201502174-1 -1 Checker Board 20150217A-1 6.538 25.442
2 201502174-1 -2 Checker Board 20150217A-1 5.341 44.76
1 2015021744 -1 Checker Board 2015021744 1.537 31.717
1 20150217A4-5-1 Checker Board 20150217A-5 1.626 29.103
2 20150217A4-5-2 Checker Board 20150217A-5 1.628 65.157
3 20150217A-5-3 Checker Board 20150217A-5 1.632 69.597
2 2015021746 -2 Checker Board 2015021746 3.641 45.035
< >

o Work your way from the left tab to the right.

0 - Depending on the option specified at "Start Registration" dialog, the tabs
appear on [Registration] panel vary.

Q Coordinate information from surveying is called "external reference
points."

3. Select one of the point cloud groups( 1) to register if there are multiple ones in [Tree
(Overview)] panel. Only the selected point cloud group will be the subject of registration.

Tree H
Ovenview Pipe Plane Structure Duct
=-ME Medel

B
1 20150217A-1
-[A5% 20150217A-2
A 201502174-3

bl 20150217A-4
- 2015021745
A 2015021746
-l 2015021747

0 This can be skipped when there is only one point cloud group in [Tree
(Overview)] panel.

Pencil mark (&7 ) is placed on the icon of point cloud group to register.
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Tree B
Oveniew Pipe  Plane Structure Duct

=-E Model

: Scans

bl 2015021741
[ 201502174-2
s 20150217A-3

Preparing for Registration (Optional)
User can prepare for registration in [Registration (0.Setup)] panel.

* [Fix/Unfix Scan Position] (| # )
This is a function to fix the position of a certain shot / point cloud group to use it as a
reference in registration / alignment.

Select a shot / point cloud group to fix from [Tree (Overview)] panel. Fixed shot / point
cloud group will be pinned (green) in [Tree (Overview)] panel.

Tree
Owerview  Pipe  Plane  Structure
= g Model
E-bES Scans
148 20150217A-1
[ 2mso21TA-2

* [Manage Internal Reference Points] ( 7 )
Targets (Internal Reference Points) can be edited in [Target] panel. Refer to
"Extracting Targets (Internal Reference Points)" if there are targets or internal
reference points.

* [Import External Reference Point (CSV)] (| "3 )
Survey coordinates and public coordinates can be imported. Please refer to "Import
the External Reference Points" for details.

o Depending on the options specified at "Use advanced settings" of [Start
Registration] panel, icons displayed in [Registration (0.Setup)] panel vary.

[ use advanced settings
[ Use coordinates from a total station
[ Fix the position of scan(s) as a standard
[ Enable editing of internal reference points

ance
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4.3. Registration (Auto)

Automatically register the point cloud data scanned from multiple locations with a 3D scanner
using planes, target markers, and section images.

Please note that when there aren’t any target markers when scanning with a

O 3D scanner or there aren’t much planar geometric features on the point cloud
data, such as natural objects outdoor, perform registration by Registration
(Other) .

AUTD

1. In [Registration (1. Register)] panel, press [Regist Auto] ('@ ).

Registration
0.5etup 1.Register 2Align Ref Point[EXT]

Initial registration

Position scans using extracted plnes,
l.“@“ targets etc.

2. The following dialog will appear. Click [Yes].

InfiPoints

This will reset the current layout, and perform fresh
registration. Would you like to continue?

3. "Register Auto" dialog will be displayed. When the scanned data contains compass
information, enable "Restrict rotation angle of horizontal direction from initial position".

B ' Regist Auto

Options

Restrict rotation angle of horizontal direction from initial position
Rotation angle degree

Register using detected planes

[ register using Targets (internal reference points)
Register using top view images

Q Restricting the angle of rotation in the horizontal plane reduces the
possibility of incorrect calculation results.

4. Enable "Register using detected planes", "Register using Targets (internal reference points)",
or "Register using top view images" to use for [Regist Auto].
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B ' Regist Auto

Options

Restrict rotation angle of horizontal direction from initial position
Rotation angle degree

Register using detected planes

[ Register using Targets (internal reference paints)

Register using top view images

Align altitude of point doud groups to Z=0 vidnity

ﬂ Multiple selection is available. At least one of the three has to be selected.

5. Specify target pairs when necessary.
o Specifying pairs manually

= Select [Add adjacent point cloud] (|*= ) with at least two point cloud shots selected.

e.g., Selected point clouds will be set as pairs (No. 0-2 in the case above).

Mear shot pairs
i i i Pair  Pair  Pair  Pail |

20150217A-1
20150217A-2 P
20150217A-3 -

7 4

2015021745 3 5 A
4 6 S
5

Mum
2|

3
4
5
6
<

20150217A-6
20150217A-7

o Estimating pairs from the target
= Press [Add Pair Shots by Internal Reference Points] (| |).

= If there are no point cloud pairing information, this menu is used.

Mear shot pairs
Mum Mame of point doud Pair Pair Pair Par Par Par  Paill | -
0 20150217A-1 1
1 20150217A-2 o] 2 i
2 20150217A-3 1 3 —
3 20150217A-4 2 4 =l
4 20150217A-5 3 5 A
5 2015021746 4 & =
[ 20150217A-7 5
< >

Corce
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As more pairs are set for each point cloud data, the success rate of
automatic registration can become higher, but the processing time
could increase.

(Ex.1) Selecting one neighboring point cloud as pairs for each scan

O e 1?2

il
-

(Ex.2) Selecting multiple neighboring point cloud as pairs for each

scan
|_E_' 1
32X

F Y

h
F Y
h
N

-

S| 43
6. In [Regist Auto] panel, click [OK] to start auto registration.
3 il
4 5 =
5
>
Cancel

Please note that if the project data is out of date, the following dialog may
appear. Click [Yes] as is to update the required data.

2D Registration *

This project was created in a former version, which may cause
g inaccurate results in evaluation of scan registration (consistency
SCOres).

Click [Yes] to regenerate necessary data prior to the evaluation
(Recommended), or [Mo] to run evaluation on the current data.
Please note that this process may take long.

Each process could be monitored at the bottom right corner status bar.

Q Front Wiew | Clipping | Section Property
| cancet |

7. Click [OK] in the dialog, and registered scans, which means "the correspondence is
detected,"” will be grouped together
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InfiPoints X
o Auto-registration finished.

When auto-registration is successful for all point cloud parts, they will be classified into one
point cloud group. In that case, select 4.5, “Aligning All Point Cloud Data” to align all.

3-¥]E3 Groupl

W 2015021741
- [1% 20150217A-2
-5 20150217A-3
Vs 2015021744
- [Vgk 20150217A-5
- [Wg% 20150217A-6
-] 20150217A-7

If not classified into one point cloud group

If there are two or more point cloud groups after automatic registration, proceed to 4.4,
“Registration (Other)”.

InfiPaints X

Failed to register some of point cloud file(s)
- because those files do not contain enough planes for Auto
Registration.

e.g., Shot #1 and #2 in Group 1, shot #3 to #6 in Group 2, but no correspondence was
detected with shot #7

Tree H
COrverview  Pipe Plane Structure  Duct
EI"E Model
B[S Scans

-5 Groups
- 2015021741
- 20150217A-2
=3 Groupz
-l 20150217A-3
- 2015021744
[ 201502174-5
- 2015021748
A 2015021747
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4.4. Registration (Other)

When auto registration does not align the point cloud data, you can perform registration in the
following ways:

* 4.4.1, “Auto Registration Using the Top View Images”

* 4.4.2, “Register by moving shots manually in [Top view/Front view] panel”

* 4.4.3, “Register by moving shots manually”

* 444, “Register by using targets (Internal reference points)”

4.4.5, “Define vertical direction of point cloud”

After manual registration is completed, move the point cloud parts from
separate point cloud groups into one on the structure tree.

Owerview Pipe  Plane Structure Duct Overview Pipe  Plane Structure  Duct
=8 Model =8 Model
= B Scans & EE&;ans
o
i M 2015021741 % 2015021741
o fe 2ois0z7A-2 [ 2mse217A-2
=] Ha 20150217A-3

- [ 20150217A-4
M 20150217A-5
[ 2015021746
s 20150217A-7

4.4.1. Auto Registration Using the Top View Images

Automatic registration can be executed by using the Top View Image. This might be effective for
registration of point cloud data which cannot be registered automatically by [Regist Auto] ( “fgﬂ

) (e.g., point cloud without scan index, point cloud taken outdoor with few artifacts).

1. Select the sub-group to move from [Tree (Overview)] panel.

5
[k 20150217A-1
[, 20150217A-2
=-03 Group2

[ 20150217A-5
[l 20150217A-6
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If [Auto-register Based on Top view] ( % ) in [Top View] panel is not
s
displayed, press [Pre-process] tab > [Register] > [Start Registration] ( =) ) to
' start registration.
o e

2. Adjust the display range in Top panel so that whole point clouds are displayed.

Top View % |

Fit Update ) o £

Q Display range can be adjusted by either of [Fit], dragging the mouse with
right clicking, or mouse wheel(zoom in/zoom out).

3. Adjust the top view section by moving the slider in [Front View] panel to ensure that the
outline of point clouds is clearly visible.

Fit Update £

4. Press [Auto-register Based on Top View] ( :* ) in [Top View] panel.
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Top View H

Fit Update & 5 A

Top View E

Fit Update @[]«

Q You can cancel the last move by selecting [Undo] ( £+ ) in Top panel.
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4.4.2. Register by moving shots manually in [Top view/Front view]
panel

You can correct the relative position of shots / point cloud groups that are not registered by
auto-registration by moving and rotating them in [Top View] / [Front View] panel. Following is
the way to manually arrange sub-groups in proper positional manner.

1. Select a shot / sub-group to move in [Tree (Overview)] panel.

5@
A5 20150217A-1
[l 20150217A-2
=103 Group2

[k 20150217A-5
[k 20150217A-6

Handles for movement will appear on [Top View]/[Front View] panel.

When moving handle does not appear for neither top nor front panel,
please check the followings:

' o Has registration started already?

o Were point cloud part or group that are a part of the registration group
selected?

2. Move or rotate the selected shot or the selected point cloud group in [Top View] / [Front
View] panel by dragging the following:

> Yellow handle O : To move parallel

o Pink handle @ : To rotate
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Top View x|

Fit Update & o £ Fit Update &

Bring the mouse cursor over the handle to show buttons to move / rotate by specified
distance only.

. |} : Press this to move by the distance / rotation for the angle specified at [Settings]
only

. D : Press this to move / rotate at three times the value specified at [Settings]
(This is not available unless [Show handles to move/rotate shot] is enabled in
[Settings on Data Registration].)

Settings on Data Registration
Show handles to movefrotate shot

Move distance of [Move] icon o1 o

At this phase, please ensure that all shots are placed at roughly right

9 positions (no need to register precisely for now) for the next phase
(automatic alignment in [Registration (2.Align)] panel).

Q You can also use [Move] ( 525 ) to move shots / point cloud groups in
3D View Window.
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Point Cloud Display Method

* [Top View] / [Front View] panel displays point cloud data in section view.
To improve the work efficiency, adjust the section width for [Top View]
panel by moving blue bars in [Front View] panel.

Top View H

Fit Update ]

* [Classify Points by Color] ( E@ ) Color points per scan shot. This is effective
to visually check the relative position of registered shots.

v .

Overview Pipe  Plane Structure Duct
=-ME Model

-
[ 20150217A-6
Mi% 20150217A-7

You can further improve the visibility by showing two or three relevant
shots only, and switching to "Section Mode".

Tree |x || Section Mode

Overview Pipe  Plane Structure Duct
=8 Model
=- M3 Scans
=M Groupt
0

[O:% 20150217A-6
% [20150217A-7
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4.4.3. Register by moving shots manually

You can also correct the relative position of shots / point cloud groups that are not registered by
auto-registration by moving them in 3D View Window.

ScanB

Eh-.m’ Scand

1. Open [1.Register] in [Registration] tab. Enable [Enable manual registration] and select [Move
Point Cloud Group/Shot Manually] (|4 ).

N5et up  1Register 2 4lien  Ref. Point [EXT]

Initial registration

AuTo  Position scans using extracted planes,

® targets etc. QQ » il

[ Enable manual registration

Move by external file <= | Move Point Cloud Grou

Shot Manually

Move Point Cloud Group / Define the vertical direction
* | Shot to Align by Internal
Reference Points

2. Check in the checkbox to restrict the movement by fixing the coordinate value if necessary.
E.g., Enable "Fix X value" and "Fix Y value" in [Option] panel to move parallel along Z axis
(change Z value only). Or shot / point cloud group will be moved to any direction.

Options
'nlﬁ P

[CFix X value

[CIFix f value

[CFix Z value
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3. Select a shot / point cloud group to move in [Tree (Overview)] panel.

Tree x|
Overview Pipe  Plane Struc ¢ |*
=-[F1E) Model
=] Scans
--[J@@ Group1
i3 [20150297A%
0 EErs
-3 Group2
M5 20150217A-6
[ Boiso217A-3
[J:5% 20150217A-4
[ 20150217A-7

Please note that you cannot move fixed shots / point cloud groups. (You
need to unfix them first.)

InfiPoints ot

0 Point cloud group / shot to move contains point cloud group /
! shot whose position is fixed, Release the fix in [Registration
[Prepare]] panel to move those point cloud group / scan.

4. Specify a point #1 to move in 3D View Window.

g
" roidesd R i
Y Point Cloud Vertex

Specify a point #2 to move to in 3D View Window.

¥ Point Cloud Vertex

Selected shot / point cloud group will be moved to match #1 point to #2 point.
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In case that the position of point clouds is not aligned properly, move the slider
in Front panel to adjust the outline of point clouds and run [Register using top
view images] ( #* ) again.

Front View a
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4.4.4. Register by using targets (Internal reference points)

By setting a target (internal reference point) in a common place without moving the point cloud

part in each group, the groups' position can be aligned by matching the targets.

Relation between Group 1 and Group 2

e Group 1

Tree

Overview Pipe  Plane  Structure  Duct

= E Model

(3 Scan

B Group |
i

B
=

6 LS07364 023
=23 Groupz

4 L507264_027

Top View x|

* Group 2

Tiee

Overview Pipe  Plane  Structurs  Duct

=8 Model

B& Scans
213 Group1
6 LS07364 020

Top View x|
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1. In [Registration (0.Set up)] panel, press [Manage Internal Reference Points] ( \.( ).

B
0.3etup 1 Register 2Align Ref Point[EXT]

Additional information to use in registration

# | Fix/Unfix Scan Position

»/| Manage Intemnal Reference Points

5 | Import External Reference Point (CSV)

Please note that when [Manage Internal Reference Point] ( \.{' ) does not
appear in [Registration (Step 0)] panel, then set the following in "Start
Registration" dialog.

o Select "Yes" for "Was scanning conducted using target markers such as
spheres and checkerboards?"

- Enable "Use advanced settings" and "Enable editing of internal
reference points".

Start Registration d

Specify scan registration settings, and then click [Start].

application, e.g., one from a scanner vendor?

Oes ® Ho

*Select [Yeg] to maintain the registration result and refine the registration

9 J ,.,' Are you registering scans which have already been registered in another

5 accuracy only, or [Ma] to run an initial registration regardless.
Elysium '
.
InfiPoints.
Was scanning conducted using target markers such
as spheres and checkerboards?
® Yes ONo |

Use advanced settings I
Use coordinates from a total station
. Fix the position of scan(s) as a standard
‘ Enable editing of internal reference points I
s

Cancel

2. Specify the point cloud part to edit in [Tree (Overview)] panel.

Tree H
Owerview Pipe  Plane  Structure  Duct
=-E Model

=A% Scans

=3 Group1
i e LSoT384_020
%, LSo7364_021
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Viewpoint of "3D View" window will move to the scanned origin of the specified point cloud
part. Also, only the specified point cloud part will be shown; others hidden.

Tree x|
Overview Pipe  Plane  Structure  Duct

=S Model
= .@ Scans
B .D Groupi
e B L507364 020
SPS o L507364_021
|:| o L507364_022
% LS07364_022
B .D Group2
-5 Ls07364_024
- LS07364 025
-[]s# LS07364_026
-[Je LSo7364_027

Target
|>=:. X ||z =
Valid  MName Type: Shot name

4. "Create Internal Reference Points" dialog will appear. Switch the type to "Free Hand (On
Point Cloud Only)", then click [OK].

Create Internal Reference Points

Select a type of internal reference

points.
Free Hand (On Point Cloud Only)
Cancel

5. When selecting a point at the position where you want to create a target (internal reference
point) in "3D View" window, the target (internal reference point) will be created.

"Checker Board" is also selectable as a target type to create a target
Q (internal reference point). Please refer to "Create targets manually (Checker
Board)" for more details about how to create targets with "Checker Board".
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Please note the following when creating internal reference points to avoid
inverting the left and right during registration.

A

o Select points, but try not to line them up in a straight line.

- Try to select one or more points that are not on the same plane.

- Please note that when the target (internal reference point) does not
appear on "3D View" window, press [Hide Internal Reference Points] (
0 =_|) of [Target] panel and switch to [Show Internal Reference Points in
"3D View" Window] (| = |).

o Target (internal reference point) will not appear on the structure tree.

Information about the target (internal reference point) can be confirmed on [Target] panel.

Target x|
Fe || Al | TS p.o | Unit : m
Yalid  MName Type: Sk

1 L507364_023 -1 Free Hand (On Point Cloud Onby) LS
2 L507364_023 - 2 Free Hand (On Point Cloud Onby) LS
3 LS07364_023 -3 Free Hand (On Point Cloud Only} LS
4 L507364_023 -4  Free Hand (On Point Cloud Onby) LS

< >

6. Press [Cancel the selection and quit this function] ( @ ) to finish creating the target
(internal reference point).

7. Next, among the point cloud parts belonging to Group 2, specify the point cloud part in the
structure tree which includes the scanned object used as the target (internal reference
point) created earlier.

Tree % |

Overview  Pipe  Plane  Structure  Duct

=& Model
EI@ Scans

BD Group

- L[4 LSo7384_020
1%, LS07364 021
- LS07364_022
¢ L[ Lso73e4 023
al?h Groyp?

1 % 1507364 024
T T, [S07364.005
-[s% LSo7364_026
-[15% LS07364_027

8. Again, press [Add] (| “|) in [Target] panel.

9. "Create Internal Reference Points" dialog will appear. Switch the type to "Free Hand (On
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Point Cloud Only)", then click [OK].

Create Internal Reference Points

Select a type of internal reference
points.

Free Hand (On Point Cloud Only) ~ |

F ok | Cancel |

10. On "3D View" window, pick the same location as the target (internal reference point) you
just created, and create a target (internal reference point).

=L

el A= )¢ | Unit : m

Valid  Mame Type: Sk
1 L507364_024 -1  Free Hand (On Point Cloud Onby) LS
2 LS07384_024 -2 Free Hand (On Point Cloud Only} LS
3 L507364_024 - 3 Free Hand (On Point Cloud Onby) LS

< >

11. Press [Cancel the selection and quit this function] ( @ ) to finish creating the target
(internal reference point).

12. Select [Finish Editing Internal Reference Points] (| ® |) on [Target] panel, and finish editing
the target (internal reference point).

13. In [Registration (1.Register)] panel, press [Move Point Cloud Group / Shot to Align by

Internal Reference Points] (| = |).

#2 ELYSIUM © 2023 Elysium Page 54 | 137



Elysium InfiPoints Operation Manual Vol.1. Data Pre-processing

0.5etup 1.Register 2Align Ref Point[EXT]

Initial registration
AUTO 'F;orsrléﬂ esgms using extracted planes,

@ Mroeset Q " ;
[~ Enable rmanual registration J

Move by external file .= | Move Point Cloud Group /
Shot Manualy

Mowve Point Cloud Group | Define the vertical direction
“ | Shot to Align by Internal

Reference Points

14. In this case, disable "Fix z-axis" in [Option] panel.

'n.-ﬁ- Option

[JFix z-axis

15. Select "Group 2" from the structure tree to specify which point cloud group to move.

Overview  Pipe  Plane  Structure  Duct

=8 Model

EE@ Scans
E@ Groupl
L[4 Lso7384_020
-] LSo7364_021
[, LS07364_022

[, LS07384_025
[ LS07364_026
[, LS07384_027

Select "Group 1" in the structure tree to specify the target point cloud group.
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"Group 2" will move to match "Group 1".

®m 3D View window

® Top panel

Top View

Fit Update

Tree

Owerview  Pipe

Plane

Structure  Duct

=N
=

=-E Model

M3 Groupt

L

&3 Groupz
-5, LS07364_024
[, LS07364_025
LS07364 026
-2, LS07364_027

:
2%

[l Lo07364_020

% LS07364_021

% LS07364_022
LS07364 023
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4.4.5. Define vertical direction of point cloud

You can specify the vertical direction for scan shot (or point cloud group) whose vertical
direction is not available. This function is effective for registering point cloud data from handy
scanners or point cloud data without scan index data.

m Define the vertical direction by a plane for the floor

1. Select [Registration (1.Register)] panel, check "Enable manual registration" option, and click
[Define the vertical direction] (| = ).

Registration x|
N5etup 1Resizter 2 Alien  Ref. Point [EXT]

Initial registration

Position scans using extracted planes, iﬁ_-'“'
ey 3y
@ targets efc. .;‘: E"h# & ]
o . LS I
rr——;}E +.Ir

Enable manual registration _

(&

e

Move by external file

Move Point Cloud Group /
Shot to Align by Internal

= | Move Point Cloud Group /
*+ | shot Manually

> Define the vertical direction

Reference Points

2. Specify a method in [Option] panel. Select "By a plane for the floor" option as an example
here.

Option
aﬂ Options

How to define the vertical direction
I (®) By a plane for the floor I
(_JBy a plane for the ceiling

() By a vertical pipe
[ also mave to the world origin

3. Select the target scan / scan group in either [Tree (Overview)] panel or the 3D View window.
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Tree E

Owerview Pipe  Plane  Structure  Duct

=-E Madel

- 2015021741
[k 201502174-2
% 20150217A-3
- 201502174-4
% 20150217A-5
- 20150217A-6
~[e%, 20150217A-7

4. "Define the vertical direction" dialog will appear when the selected scan / scan group does
not include any planes just under. Here, select "Auto-extract” and click [OK].

Define the vertical direction ot

There is no plane [ pipe that belongs to the selected scan f
scan group, so please prepare one temporarily.

Select how to prepare a plane / pipe to define the vertical
direction, and then dick [OK].

(®) Auto-extract
(Please note that this may take long.)

() Create manually

Cancel

Please note that the function to auto-extract planes and pipes does not
work on point cloud data without scan index data.

Define the vertical direction h:4

There is no plane / pipe that belongs to the selected scan / scan

group, and cannot auto-extract because the scan index data is not
available. Please create a plane / pipe manualky.

Gance

The plane will be auto-extracted.

Define the vertical direction *
Extracting pipes and planes... 51% completed

Cancel
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5. Select the plane to define as the floor from the extracted plane on the 3D View Window.

Plane [GES]

The point cloud will move so the Z-axis will become perpendicular to the chosen plane.

m Define the vertical direction by a pipe

1. Select [1. Register] from the Pre-process tab. Check On [Enable manual registration] and
select [Define the vertical direction] (| L= ).

#2 ELYSIUM © 2023 Elysium Page 59 | 137



Elysium InfiPoints Operation Manual Vol.1. Data Pre-processing

Registration x|
NSetup 1PReeizter 2 Alien  Ref. Point [EXTI]
Initial registration

AuTo | Position scans using extracted planes, .

@ targets efc. f’ﬂ';\. ,: ; ] ]

k
&1
1

[ Enable manual registration —_—

Move Point Cloud Group /

i~ | Move by external file 5
- Shot Manually

| Move Point Cloud Group / s Define the vertical direction
Shot to Align by Internal
Reference Points

2. Specify the method from the Option panel. In this case, select "By a vertical pipe".

Option
ﬁ-ﬂ' Options

How to define the vertical direction
() By a plane for the floor
(_JBy a plane for the ceiling
(®) By a vertical pipe

[J also move to the world origin

3. Select one of shots/point cloud groups to specify the vertical direction from either [Tree
(Overview)]tab or the 3D View Window.

Tree H
Overview  Pipe  Plane  Structure  Duct
=& Model
-5 Scans
M 2015021741
g
[k 2015021744
s 20150217A-5
i 20150217A-6
LfAe% 2015021747

4. If the selected shots/point cloud groups do not have any pipes just under, "Define the
vertical direction" dialog will appear. Here, select "Create manually" and click [OK].
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Define the vertical direction ot

There is no plane [ pipe that belongs to the selected scan f
sCan group, so please prepare one temporarily.

Select how to prepare a plane / pipe to define the vertical
direction, and then dick [OK].

() Auto-extract
(Please note that this may take long.)

(®) Create manually

Cancel

5. On the 3D View Window, pick two points where you would like to create a pipe.

Foint Cloud

6. Select the created pipe. A dialog will appear, asking if you would like to rotate the scan/scan
group upside down?
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7. If the vertical direction is correctly displayed in the preview of "3D View" window, then click
[Yes]. To turn it upside down, click [No].

hod

Does the vertical direction in the preview rmatch your intention? Click
[Yes] to continue as is, or [No] to rotate the scan f scan group upside
down.
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4.5. Aligning All Point

Cloud Data

Following is the way to adjust scan shots to minimize the error of whole point clouds based on

the result of Registration.

1. Move to the [2. Align] tab in the [Registration] panel and select the [Align All] :Dj .

o

0.Setup

1.Register 2.AllgN  Ref Point [EXT]

Refine the registration (Finalize)

H

Refine using Z axis, targets, top view
images efc.

2. Specify "Restrict Z-axis rotation from the original direction" in the "Align all point cloud

data" dialog and click [OK].

Align all point cloud data ot

Align shots in sub-group

[] align shown shots only

Restriction on Z-axis rotation

() align to original Z-axis direction

I@ Restrict Z-axis rotation from the original direction I

Do

Elements to use for [Align All]
Feature shape
[Jinternal reference points (Reffrence sphere)
[Jinternal reference points (Chetker board)
[ internal reference points (Fre® hand)

|:| Top view images

degree(z)

not restrict Z-axis r@gtation

Cancel

o There are cases where small errors are found in the z-axis direction, but accepting this
error allows a more accurate registration as a whole.

Q Amount of error between point clouds could be examined in the
[Check] tab of the [Registration] panel.
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Align shots in sub-group option

* Check this option to align per scan shots, or check off to align per sub-group
(fix the positioning within each sub-group).

=M Scan

Tty 20150217A-1
[ 2015021742
[ 2015021743

e

il 20150217A-5
LA 2015021746

0 * Please ensure that there are at least two sub-groups when this option is
checked off.

InfiPoints *

Cannot run the requested command because there is only a
| single point cloud group.

You can also align using [Fix/Unfix Scan Position] in combination.

* Per shot ("Align shots in sub-group" option checked) while fixing the
position of certain shots

* Per sub-group while fixing the position of certain point cloud groups

Restriction on Z-axis rotation option

 This is to improve the registration accuracy by specifying the restriction on

Z-axis rotation. This is effective because the accuracy of the inclination
Q sensor differs depending on the scanner specification. Specify the

maximum allowed angle for Z-axis rotation to allow to align scan shots /
point cloud groups while rotating them along Z-axis (vertical direction)
within a tolerance. Select an optimum option (and tolerance value when
selecting second option) based on the specification of the inclination sensor
of the scanner used in scanning.
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Elements to use for [Align All] option

*» Please select target types (reference sphere / checker board / free hand)
created in [Registration (Check)] panel.

———
0.8etup 1.Register 2.Align Ref Point[EXT] Check

; v Check By target ~

Paired Targets Type: Mean value[mm] Max. value[mm]
Paired Targets1  |Checker Board | 27.606 27.606

Paired Targets2  |Checker Board | 2.972 4.272

Paired Targets3 22.717 36.203

* [Align All] can be executed while fixing the position of multiple scan shots
by [Fix Scan] (| # ).
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4.6. Check Registration Result

Check the accuracy of registration. Based on targets or extracted planes, the gap between
multiple point cloud parts can be checked numerically.

Please note that checking the accuracy of Registration is extremely important
0 when using point clouds for engineering purposes such as measuring,
drawing, and interference checking.

' The check function may not detect all errors. Please ensure to check visually
—_ as well.

1. In [Registration (2.Align)] panel, click [Go to [Check] Tab].

Registration % |
0Setup 1Register 2.Alen  Ref Paint [EXT] Check

Refine the registration (Finalize)

I 1 Refine using Z axis, targets, top view

images efc. ’

Check registration accuracy after alignment

| Go to [Check] Tab |

9 Enable "Check registration accuracy after alignment" in [2.Align] tab to
automatically switch to [Check] tab after "Align All" is finished.

2. [Check] tab of [Registration] panel will appear. Click [ChecK].

o
0Setup  1Reeister 2Alien Ref Point [EXT] Check
v Check By scan shot w -]
Shot name Consistency score  Max. val

3. "Check" dialog will appear. Select "Check gap by extracted planes" and click [OK].

Check >

() Check gap by targets

I@ Checdk gap by extracted planes I
cance

Q When scanning with targets in place, you can also use the targets to
evaluate.
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4. Select [Registration] panel > [Check] tab to display the evaluation result for each point cloud
part on the list.
In "consistency score (mean) [%]", you can confirm the mean value of evaluated scores for
registration consistency with adjacent scans.

Registration |
0Setup 1Resister 2Alien  Ref. Point [EXT] Check

W Check By scan shot L

Shot name Consistency score... fMedian value... Estimated max. ... Mo. of checked p...
2015021741 96.7 1.981 10.924 2098
20150217A-2 96.2 1.751 16.181 1494
20150217A-3 96.6 2.814 12.861 536

2015021744 97.7 1.416 7.862 553

20150217A-5 971 1.535 6.18 452

20150217A-6 97.4 3.641 21.395 347

20150217 A-7 a8 2.577 10.466 542

v | Export Check Result Report “m  Finalize Resistration

Consistency threshold is set at 75% by default. You can change the value in
"Minimum acceptable consistency score in data registration” from the
"Settings" dialog.

Settings X
Maximum distance between targets to regard as identical mm
Maximum distance between planes to regard as identical 100 mm
Ratio to estimate largest gap between planes o
Maximum acceptable gap distance in data registration ([Top] panel) mm
Q Minimum acceptable consistency score in data registration o

Cancel

- The median represents the value of gap which exists at 50% of the total
number of gaps in the points to be evaluated.

o The estimated maximum value displays the largest gap value among
95% of all evaluated points, considering the remaining 5% of the total
points as noise. The recommended estimated maximum value for
registration is within 5 mm for indoors and within 10 mm for outdoors.

5. Right-click on the list, and select "Show Check Result between Two Shots" from the context
menu.
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_
0Set up  1Register 2Alien  Ref. Point [EXT] Check

v Check By scan shot ]
Shot name Consistency score... Median value... Estimated max.
20150217A-1
20150217A-2 Show Gap between Shots by Extracted Planes
2015021744 Meove to Origin
20150217A-5 o971 1.535 6.18

A "Show Check Result between Two Shots" dialog will appear. In "consistency score[%]", you
can confirm the value of evaluated scores for registration consistency per scan pair.

B ' Show Check Result between Two Shots >

Median value[mm]  Estimated max. value[mm]

3.52 11,721
7.091 20,441

Consistency score[%]

Adjacent shot

20150217A-5
20150217A-6

Also, the "consistency score (mean) [%] per scan pair" can be confirmed in [Top] panel.

Top View H

Fit Update B e
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If the evaluation result has not reached the normal value, both the cell and the
text color of consistency score are displayed in red.

Consistency score (Mean)[%] Median value[mm] Estimated max. value[mm]

72 1.981
91.3 1.751
92.8 2.814
93.9 1.416
74 1.535
0.4 3.641
94.8 2.577

10.924
16.181
12.861
7.862
6.18
21.595
10.466

o If the value is lower than the threshold set at "Minimum acceptable
consistency score in data registration”, the text color of consistency will

turn red.

* In "Show Check Result between Two Shots" dialog, when at least one

i

consistency is lower than the threshold value set in "Minimum acceptable

consistency score in data registration”, the "consistency score (mean)" cell
is highlighted in red.

2 ELYSIUM © 2023 Elysium

Consistency score (Mean)[%] Median value[mm] Estimated max. value[mm]
I 4 oo | I
91.3 Show Gap between Shots by Extracted Planes
92.8 Show Check Result between Two Shots
93.9 Mawve to Origin
74 oo orro
90.4 3.641 21.595
04.8 2.577 10.466

B " Show Check Result between Two Shots

s

Adjacent shot
20150217A-2 95.7 1.144
20150217A-5 35.2 3.52

2015021746 85.2 7.081

Consistency score[%¢] | Median value[mm] Estimated max. value

4,201
11.721
20,441
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4.7. Finalize Registration

4.7.1. Extracting Targets (Internal Reference Points)

m Create targets automatically (Checker board)

1. From the [Registration] panel > [0. Set up] tab, select the [Manage Internal Reference Points]
( “-( ) and open the [Target] panel.
S

0.5etup 1.Register 2.Align Ref Point [EXT]

Additional information to use in registration

# | Fix/Unfix Scan Position

# | Manage Internal Reference Points

b | Import External Reference Point (CSV)

1

- *
ol | K| |5 pd Unit 2 m
Valid  Name Type: Shot name  Distance from scan Angle toward

o Coordinates of checker board and/or spheres placed at the time of scan
is defined as [Internal Reference Points].

> [Manage Internal Reference Points] (| ) will be displayed in [0.Set
up] tab of [Registration] panel only when the "Enable editing of internal
reference points" is enabled in advanced settings at the start of the

ﬂ registration.

Use advanced settings

[Juse coordinates from a total station

[J Fix the position of scan(s) as a standard

Enable editing of internal reference points

Cancel
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2. In [Target] panel, press [Extract] (| <= |).
On [Tree (Overview)] panel, select the point cloud or point cloud group on which you want
to create reference points.

Tree H
Overview  Pipe Plahe Structure  Duct
E--Mudel
oA Scans

A, 2015021741
s 20150217A-2
[ A 20150217A-3
[l 20150217A-4
[ 2015021745
A 20150217A-6
- 20150217A-7

3. The following dialog will appear. Click [OK].

InfiPoints o4

Switching to [Display Intensity] mode.

You can raise the success rate in checker board extraction
[recognizing the center of the checker board) by narrowing the
intensity range to use.

4. "Recognize reference points" dialog will appear. Enable "Recognize checker boards".

Recognize reference points .

Recognize checker boards
[Jre-extract checker boards

Size 0.15 m

Effective intensity range

I¥lin 0, 000000

o If "Re-extract checker boards" is enabled, you can specify "Effective intensity range".

o Users can adjust the intensity range to distinguish the black and white appearance of the
checker board.
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Recognize reference points x

Recognize checker boards
I Re-extract checker boards I

Size 0.15 m

Effective intensity range
Min [ 0.000000

Mas. ] 0.130129

D Recognize rotating targets only

[ Also recoanize targets in Z-axis direction from scanner

= Example of using the Effective intensity range

0.0-1.0 0.0-0.13

ﬁ)'\ 2

5. When using a reference sphere, enable [Recognize reference sphere].

Recognize reference points >

Recognize checker boards
Re-extract checker boards

ol mi

Effective intensity range
Min . 0.000000

Ma. . 0.130129

D Recognize rotating targets only

[ Also recognize targets in Z-axis direction from scanner

Recognize reference spheres

[Jre-extract Reference Spheres

6. Click [OK] in "Recognize reference points" dialog. The target is extracted.
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IE‘ Unit : m

Valid  Name Type: Shot name Distance from scan Angle g

M1 20150217A-5-1 Checker Board 20150217A-5 [1.626 29.103

12  20150217A-5-2 Checker Board 20150217A-5 [1.628 65.157
3 20150217A-5 - 3 Checker Board 20150217A-5 f§1.632 69.597

o Within the extracted reference points, check for over detection or under detection of
points.

(Ex.) Over detection

Reference point is detected
where there are no markers

Delete reference points at the [structure] panel

7. Return back to the [Registration] panel by selecting [Finish Editing Internal Reference
Points] | M | in the [Target] panel.

%5 E X [=]

Valid  Mame Type: Shot name

[4]1  20150217A-5-1 Checker Board 20150217A-5
42  20150217A-5-2 Checker Board 20150217A-5

Case A: Execute "Import External Reference Points"
Case B/C/D: Proceed to "Regist Auto"
Please refer to "Registration Using InfiPoints" for each "Case".
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m Create targets manually (Checker Board)

1. From [Registration (0. Set up)] panel, select [Manage Internal Reference Points] (

|U-SEtUD 1.Register 2.Align Ref Point [EXT]

Additional information to use in registration

Fix/Unfix Scan Position

Manage Internal Reference Points

Import External Reference Point (CSV)

2. Select a scan shot to create targets from in [Tree (Overview)] panel.

EI@ Scans
[ 2015021741

.
5

&
> o

Only the selected scan shot is displayed on "3D View" window, and the center of the

viewpoint will shift to the origin of the selected scan shot.

2[5 Scans
148 2015021741

s 20150217A-2
[ 20150217A-3

3. Press [Add] (| “|) on [Target] panel.

elPx][=] [X] [¥]

Valid  Name Type:

4. "Create Internal Reference Points" dialog will appear so specify a target type.
In this case, specify "Checker Board", and click [OK].
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Create Internal Reference Points

Select a type of internal reference

points.

[ o ][ cancal |

v

"Reference Sphere" and "Free Hand" are also selectable as a target type.

5. Click a point on "3D View" window to create a target; this time, click around the center of
the checker board.

6. The following dialog will appear. Click [OK].

Display mode of "3D View" window will switch to "Display Intensity" mode.

InfiPoints hot
o Switching to [Display Intensity] mode.

You can raise the success rate in checker board extraction

[recognizing the center of the checker board) by narrowing the
intensity range to use.

7. "Recognize reference points" dialog will appear. Adjust the effective intensity range by
moving the slider in the dialog to clearly distinguish black part and white part.

Recognize reference points

- @ E '

Effective intensity range

*

Min [ 0.000000
Max. f 0.126436
[ ok ] cancel

The intensity in "3D View" window changes as you move the slider.

(Example) Min. 1.0 - Max. 0.13

¥ ELYSIUM © 2023 Elysium
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Adjust the Effective intensity range and click [OK] to add the target.

CAL-112

Targets are added for each scan shot and can be checked on the target panel.

Target
ol | A 3 b e
Valid  Name Type: Shot name

2 20150217A-3-2 Checker Board 20150217A-3
3 20150217A-3-3 Checker Board 20150217A-3

Registration Target
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4.7.2. Importing the External Reference Points

1. From the [Registration] panel > [0. Set up] tab, select the [Import External Reference Point
cswl|s .

E——
0.5etup 1.Register 2.Align Ref Point[EXT]

Additional information to use in registration
# | Fix/Unfix Scan Position

\.( Manage Internal Reference Points

[Import External Reference Point(CSV)] (| "3 |) will be displayed in [0.Set
up] tab of [Registration] panel only when the "Use coordinates from a total
station" is enabled in advanced settings at the start of the registration.

Import External Reference Point (CSV)

0 Use advanced settings
Use coordinates from a total station

[IFix the position of scan(s) as a standard
[JEnable editing of internal reference points

Concel

2. Specify the coordinate file (.csv) from the survey and click [Open].

@ Open *
uk <« ELYSIUM » Sample v O ' Search Sample
Organize ~ Mew folder ==« [H 9
Mame Type Date medified
7 Quick access
| B | CSV File 9/26/2021 6:00 PM
@ OneDrive
[ This PC
[_} Metwork
< >
File name: |text.csv V| CSV File (ANSI enceding) (F.csv v

o The reference points made in InfiPoints will automatically fit to the imported

coordinates.
= In order to import external reference points, you need to prepare
0 beforehand.
= Match the internal reference points to the external reference points

to increase the accuracy of the registration.
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External reference point preparation

Name | X coordinate {(m) : Y coordinate (m) : Z coordinate (m)
AD 0.0450 0.8790 0.0010
Al 0.0000 0.0000 1.7870
A2 0.0000 0.0040 0.4940
A3 -4.2380 29780 0.2790
AL 01060 5.6840 1.2750
AD 4.3880 3.6720 1.9530
Bl 25.5160 -0.0510 05280
B2 19.9600 -13.2990 0.3960
B3 16.3430 -8.5650 0.3220
B4 24.0720 -4.3960 1.8390
(gl 8.9570 23.3730 11140

v

¢ Survey_cordinatest_m.csv - Notepad
File Edit Format ‘iew Help
A1,0.000,0.000,1.787
42,0.000,0.004,0.494
A3,-4.239,2.978,8.279
44,8.106,5.684,1.275
45,4.388,3.672,1.953

Create a CSV file of surveyed coordinates to import them into InfiPoints.

Create a CSV file based on the x,y,z

coordinatesof every target point

D14 > e

A B | C D
1 Al 0 0 1.787
2 A2 0 0.004 0.494
3 A3 -4.239 2.978 0.279
4 5.684 1.275
5 3.762 1.953

1 row per target point (point name, x, v, z)

Importing units of the reference points will be determined by the
settings in [Application Menu] > [Option] > [System Preference] >

[Miscellaneous] > [Length Units].

Please ensure that CSV file unit system and InfiPoints unit system

(meters, etc.) are the same.
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4.7.3. Aligning by External Reference Points

This is a function to import the coordinate value of external reference points (survey
information of reference spheres / checker boards), and align shots (adjust their position and
angle) to achieve the registration accuracy that compares to that of survey.

1. In [Registration (Ref. Point [EXT])] panel, press [Align by External Reference Point (Point
Cloud Group)] (|-= ). "Align by External Reference Point (All)" dialog will appear.

S

0.Setup 1.Register 2Align Ref Point[EXT]

Act Mame X[m] ¥[m] Z[m] Allowable Errorfmm]

2. To keep the Z-axis, enable "Fix Z-axis" and then click [OK].

Align by External Reference Point [All) X

Fix Z-axis

|Use external reference points paired with paired targets

Cancel

If the external reference points are specified for the target group in
[Registration (Check)] panel, and if "Use external reference points paired
with paired targets" is enabled in "Align by External Reference Point (AlD)"

dialog, the specified external reference points are forced to be the

corresponding points.

Registrati

Align by External Reference Point (All) *

Fix Z-axis

I Use external reference points paired with paired targets I

Cancel

0.Setup 1.Register 2.Align Ref Point[EXT] Check

v Check By target w
Paired Targets Type: Mean value[ Max. value[ External reference point name
Paired Targetsl Checker Board  27.575 27.575 |—
Paired Targets2 Checker Board  20.547 29.859 -
Paired Targets3 Checker Board  23.151 36.008 2015021743
= 20150217A-4
20150217A-6
— 20150217A-7
v. | Export Check Result Report ] nalze Hegr

Shots will be aligned.
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e.g., Set world coordinates (0,0,0) to the left corner of the building

ﬂ Please ensure that each shot has at least three targets that correspond to
external reference points (or two when "Fix Z-axis" option is enabled).
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4.8. Finalize Registration

1. In [Registration (Check)] panel, click [Finalize Registration].

21.595 47
10.466 42

#EJ Finalize Registration

To finish Registration without performing any checks, disable "Check

registration accuracy after alignment" option in [Registration [2.Align)]
panel and click [Finalize Registration].

o
0.Setup 1.Register 2Align Ref Point[EXT] Check

Refine the registration (Finalize)

Refine using Z axis, targets, top view
II:Q images etc.

[]Check registration accuracy after alignment

e

Go to [Check] Tab

-

] Finalize Registration

2. The following dialog will appear. When you click [OK], Registration will finish, and both
[Registration] and [Target] panels will be hidden.

InfiPoints X

You are about to exit "Registration” mode.
[Please note that this will hide [Registration] panel.}

Click [OK] to continue, or [Cancel] to return to "Registration”
maode,
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4.9. Defining the Origin

To define significant coordinates in the point cloud data, it is necessary to define the origin and
axis. There are two methods, [By Selecting 3 Planes] and [By Selecting 2 Points].

About defining the origin

The key is whether to keep the original Z-axis from the scanned data or not.
Decide whether to choose planes or points depending on the data.
» If the scanned data has a reliable Z-axis
> By Selecting 3 Planes (With Z-axis fixed)
> By Selecting 2 Points (on X-axis)
o By Selecting 2 Points (on Y-axis)
» If the scanned data does not have a reliable Z-axis
> By Selecting 3 Planes
o By Selecting 3 Points (on X-axis and Y-axis)

o By Selecting 3 Points (on X-axis and Z-axis)

' If the origin is defined using planes, plane models are required.
—_— Perform [Extract Planes and Pipes] in the [Pre-process] tab beforehand.

4.9.1. Selecting 2 points maintaining the z-axis direction

1. Select [Pre-process] tab > [Register] > [Define the origin] > [By Selecting 2 Points (on X-axis)] (

'y
).
* Smart Filter - FInfiPoints - D3
Hame Impaort Pre-process alysis Mod

Y L Define the origin - \F{ =
@ Keep a vertical direction :
Start ) ) o
By Selecting 3 Planes [with Z-axis Fixed) =

Registration L~
I ¢+ By 5electing 2 Points (on X-axis)

+ By Selecting 2 Points [on Y-axis)

==

Don't keep a vertical direction

©0 By Selecting 3 Planes

++ By 5electing 3 Points (on X-axis and Y-axis)

5 - By Selecting 3 Points (on X-axis and Z-axis)

ZjouLly
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2. Select point (A) close to the location where the origin will be specified.

Select the origin

Point Cloud Vertex
gordinates (x

3. Select a certain point (B) on the X-axis direction.

Select the origin

Point Cloud Vertex
gordinates (x

Origin will be set maintaining the Z-axis direction with point (A) as center and point (B)
along the X-axis direction.
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4.9.2. Selecting 3 planes

1. Select [Pre-process] tab > [Register] > [Define the origin] > [By Selecting 3 Planes] ( Qi[ﬁ ).

|43 - Smart Filter = FInfiPoints - D:
Home Import Pre-process Ahalysis Mo
;""@ LY Define the origin = \p{ =

Keep a vertical direction 2
Regisstf,r:tion %4 By Selecting 3 Planes [with Z-axis Fixed) =
. By 3electing 2 Points [on X-axis) R
= ‘s By Selecting 2 Points [on ¥-axis)
& Don't keep a vertical direction
f.0 By Selecting 3 Planes
s By electing 3 Points ([on X-axis and Y-axis)
5‘ By Selecting 3 Points [on X-axis and Z-axis)
[=}
ar

2. Select a plane to be the XY-plane on 3D View Window.

Jelect X¥-plane

3. Select planes to be YZ-plane and ZX-plane on the 3D View Window in the same way.

gelect X¥-plane

Plane: Plane [831

9 Please note that only planes almost perpendicular to the already selected
XY-plane can be selected as YZ-plane and ZX-plane.
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4. "Select" dialog will appear. As the candidate changes, the direction of the coordinate in 3D

View Window changes accordingly. Select a candidate and click [OK].

Select

(® Candidate 1
(O Candidate 2

(O) Candidate 3
(O Candidate 4

Select

(O candidate 1
(® Candidate 2
(O Candidate 3
() Candidate 4

The coordinate is transformed so that the selected planes become the XY-plane, YZ-plane,

and ZX-plane according to the order selected.
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4.10. Translating Coordinates to Match Surveyed
Coordinate Data

Coordinates of the entire project are adjusted by matching the reference points set in Elysium
InfiPoints with the coordinates surveyed by the total station, etc.

Coordinate Translation

To translate the coordinates of an entire project, you need "Reference points"”, which are
created from point cloud in Elysium InfiPoints, and "External reference points", which
are coordinates measured by surveying instrument such as a total station and saved in
CSV file format.

When using [Import External Reference Points] (Eﬁ:,) to translate coordinates, there must
be at least three reference points and at least three external reference points each.
However, when using [Import (with Z-axis Fixed) (E:%)] to translate coordinates with z-
axis fixed, there must be at least two each.

Set the reference points and external reference points so that they are in the same
relative position as shown in the figure below.

Survey Point 02

Survey Point O3

Reference Points External Reference Points

4.10.1. Creating Reference Points

Create a reference point at the point surveyed by the total station, etc.

m Create Reference Point (By Automatic Recognition)

Here, as an example, the checkerboard is automatically detected and the reference point is set.

1. Select [Pre-process] tab > [Reference Point] > [Create Reference Point] > [By Automatic
Recognition] ( (< ) from the Ribbon menu.
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* Smart Filter %

Import I Pre-process I Analysis

|4 % X
Home

FInfiPoints -

Maodeling Qutput Creation Recent

- Move PoiH[{. Create Reference Point 'Il 4 Import External Refe

;\T:"l Q%
® “®Z  4IFitto CAD / Polygon Model
Start Define the

Registration origin =
Register

+y By Coordinates...
‘t, By Selecting a Point
- ByImporting a CSV File...

By Selecting a Point in 20 Drawing

“!, By Selecting a Circle in 3D Drawing

t

=

By Selecting a Point on the Reference Sphere
By Selecting a Point on the Checker Board

By Automatic Recognition I

o
4

" Local Origin of Point Cloud with Scan Index

By Cylinder Axis

/. By Structural Axis

)Q At Intersection of 3 Planes

2. Select a point cloud group ( (1) to create reference points from [Tree (Overview)] panel.
Tree H
Overview  Pipe

B--E Madel
=} Scans

=103 Groupl

2013021741

Flane Structure Duct

H ot
F i,

o Select the [Scans] folder when defining the entire point cloud.

i

o Different from the scan shot unit "target (internal reference point)",
"reference point" will be created for each point cloud group.

3. The following dialog will appear. Click [OK].
Display mode on "3D View" window switches to "Display Intensity" mode.

s

InfiPoints

Switching to [Display Intensity] mode.

You can raise the success rate in checker board extraction
[recognizing the center of the checker board) by narrowing the
intensity range to use.

4. "Recognize reference points" dialog will appear. Enable [Recognize checker boards].
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Recognize reference points *

Recognize checker boards
[Jre-extract checker boards

0.15

5. Enable "Re-extract checker boards".
On "3D View" window, adjust the minimum and maximum values of "Effective intensity
range" so that the black and white pattern on the checkerboard can be identified while
checking the displayed reflection intensity.

Recognize reference points >

Recognize checker boards
Re-extract checker boards

- @ E '

Effective intensity range
Min [ 0.000000

Ma. . 0.130129

D Recognize rotating targets only

] Also recognize targets in Z-axis direction from scanner

- Example of using the Effective intensity range

0.0-1.0 0.0-0.13

J

)

6. Click [OK] in "Recognize reference points" dialog. Reference point will be created at the
center of the checker board.
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Overview Pipe Plane Structure Duct

=5 Model MarkerIntensityl
=M Scans e .
Group] i :
Marker MarkerIntensity2

----- [ & Markerlntensity1

@ @ Markerlntensity2

pr] @ Markerintensity3
i.f] & Markerlntensi
[l 2015021741 L :
D 2015021742 MarkerIntensity3
- [, 20150217A-3
-l 2015021744

7. On "3D View" window, confirm the automatically detected reference points. If there are
over-detection or under-detection, modify them.

(Ex.1) Over detection — Delete reference points at the [Tree (Overview)] panel

+ MarkerIntensity4

Reference point is detected where
there are no markers

(Ex.2) Under detection » Manually detect the points

A reference point is not
detected as the marker
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m Create Reference Point (By Manual Recognition)

Manually recognize the checkerboard that was not detected automatically and set the reference
point.

1. Select [Pre-process] tab > [Reference Point] > [Create Reference Point] > [By Selecting a Point
on the Checker Board] ( Fl_,:{ ) from the Ribbon menu.

| o= © + |Smart Filter | FinfiPoints
Home Import I Pre-process I Analysis Modeling Cutput Creation Recent

:“-:-'::_‘ Q\% iy Move PoirH| }i Create Reference Point v|| :"=; Impart External Refe
® L 7 Fitto CAD/ Polygon Model | | 1, By Coordinates..

Start  Definethe =
Registration origin~ %, By Selecting a Point

Register i By Importing a CSV File...
By Selecting a Point in 2D Drawing
By Selecting a Circle in 3D Drawing
o, By Selecting a Point on the Reference Sphere

I'E By Selecting a Point on the Checker Board I

.2° By Automatic Recognition

" Local Origin of Point Cloud with Scan Index
g By Cylinder Axis

By Structural Axis

iy At Intersection of 3 Planes

2. Select a point cloud group ( (1 ) to create a reference point in [Tree (Overview)] panel.

Tree H
Overniew Pipe  Plane Structure Duct

El--E Model
E| Scans
153 Group!

1l 201502174-1

[l 2015021742

[ 20150217A-3

0 Select the [Scans] folder when defining the entire point cloud.

3. The following dialog will appear. Click [OK].
Display mode on "3D View" window switches to "Display Intensity" mode.

InfiPoints o

You can raise the success rate in checker board extraction
{recognizing the center of the checker board) by narrowing the
intensity range to use,

o Switching to [Display Intensity] mode.
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4. "Recognize reference point" dialog will appear.
Adjust the marker size and effective intensity range, and click [OK].

Recognize reference points X

- @

Effective intensity range
Min 0 0.000000

Max. f) :.000000

e [

5. Select the center of the marker.

Point Cloud Vertex

Reference point is created at the center of the marker.

~sMarkerintensityl

o

If a reference point is not created, adjust the size of marker and the
0 effective intensity range in "Recognize reference points" dialog, and select
the point cloud near the center of the marker again.
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[Reference] List of Commands for Creating Reference Points

By the coordinates

% By selecting a point

}/: By importing a CSV file
K By selecting a point in 2D
drawing

EE,: By selecting a circle in 3D
Drawing

iz By selecting a point on the
reference sphere

FE?. By selecting a point on the
checker board

[+ n . s,
-°. By automatic recognition

/% By the origin from the
scanning
>/~ﬂ By Cylinder axis

;"'/w By Structural axis

>‘5;g At intersection of 3 planes

2 ELYSIUM © 2023 Elysium

This is to create by specifying a point by the coordinate
value. This is ideal to create reference points at exactly
where you wish to.

This is to create by specifying a point in point clouds.

This is to create by importing the name and the
coordinate value of reference points from CSV file.

This is to create by specifying a point in 2D drawing.

This is to create at the center of the circle by picking
the circle (drawing element) in the 3D View window.

This is to create by specifying a point on reference
spheres by the radii. There are two methods to specify
the radii: calculating from the geometry or inputting
the value if you know.

This is to create by specifying a point on checker
boards.

This is to create by recognizing checker boards /
reference spheres automatically. The reference points
will be created where the white and black cross
orthogonally for the checker boards, and at the center
point of the sphere for the reference spheres.

This is to create by specifying the scanner position
(origin). This is available for the point cloud data with
scan index.

This is to create at the specified distance along a
cylinder from either connection part (except "Joint") or
an existing reference point by specifying the Cylinder.

This is to create at the specified distance from either
an end point of the Structural axis, or an existing
reference point by specifying the Structure.

This is to create at the intersection point of 3 selected
planes.
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4.10.2. Matching Reference Points with Surveyed Coordinate Data
(CSV)

The entire coordinates are translated according to the coordinate values of the measurement
points surveyed by the Total Station, etc.

Preparation

* Create a CSV file to import the survey instrument coordinates into InfiPoints.

Name | X coordinate (m) : Y coordinate (m) : Z coordinate (m)
A0 0.0450 0.8790 0.0010
Al 0.0000 0.0000 1.7870
A2 0.0000 0.0040 0.4940
A3 -4.2390 29780 0.2790
Ad 0.1060 5.6840 1.2750
A5 4.3880 3.6720 1.9530
B1 25.5160 -9.0510 05280
B2 19.9600 -13.2990 0.3960
B3 16.3430 -8.5650 0.3220
B4 24.0720 -4.3960 1.8390
(2] 8.9570 23.3730 1.1140

v Create a CSV file based on the x,y,z
coordinates of every target point
¢ Survey_cordinatest_m.csv - Notepad
' D14 e %

File Edit Format View Help

41,0.000,0.000,1.787 |, A, B | ¢ | D

42,0.000,0.004,0.494 1 Al 0 0 1.787

43,-4.239,2.978,0.279

44,0.106,5.684,1.275 2 A2 0 0.004 0494

45,4.388,3.672,1.953 3 A3 -4.239 2.978 0.279
4 5.684 1.275
5 3.762 1.953

1 row per target point (point name, x, y, z)

Coordinates will be imported as the same measurement units as seen in
’ [System Preference] > [Miscellaneous] > [Length units].
Be sure to match the units such as meters and millimeters.

1. Select [Pre-process] tab > [Reference Point] > [Import External Reference Points] > [Import] (
) from the Ribbon menu.

(% 3 ¥¢ ~ Smart Filter - FInfiPoints -

ime Import Analysis Modeling Qutput Creation Recent
%} Define the origin ~ x 5 Import External Reference Points " a:o“\, R, Color/Intensity Filter
.2 Move Point Cloud o) ‘4 Import... t+a° 2 Extract Ground
Create Referenc Remove

1{} Fit to CAD / Polygon Model Point ~ '3 Import (with Z-axis Fixed)... Noise
Register

Filter
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Please note that at least three reference points (or two if Z-axis is fixed) that
have the same positional relationship as the external reference points are

required beforehand.
Tree H
Overview  Pipe  Plane  Structure  Duct
=5 Model
O =0T Scans

2RI Marker

: Markerintensity1
Markerlntensity2
Markerlntensity3
Markerlntensity4
Markerlntensitys
Markerlntensitye
-l LS07364 020

2. "Open" dialog will appear. Specify the CSV file created in [Preparation] and click [Open].

=& Open *

« i <« |nfiPoi.. » sample_data v | 0 Search sample e

Organize v Mew folder = M @
# Quick access Mame Date modified

!@ External_survey_coordinates.csv 2020/08/23 15:22

& Onelrive
[ This PC

=¥ Network
v < >

File name: | External_survey_coordinates.csv V| SV File (ANSI encoding] (f.csv

Cancel

Coordinate information written in the CSV file is imported, and the coordinates of the entire
model are translated so that the reference points match the imported coordinate values.

[Onnrdmate system (iarld coordinate system) ]
Paint Glo

Scan Index Data = Exizts

[Ooordmate system (World coordinate system) 10 UnitSys
Faint Clo

Original Z-axiz Direction = Exist:

Mumber of Point Gloud ‘Jertlc:es = 3930310
Mumber of Extracted Planes = 478

Humber of Extracted Cylinders = 79

MHumber of Extracted Feference Spheres =
Mumber of Extracted Checker Boardz = 6
Ltice = Dicoc hiot Eocicy

Origin = (-2 20866 m, 060993 m, 136218 m) |

IoFr =4

Dizplay Color: (R:255, G:146, B:38)

2 ELYSIUM © 2023 Elysium

Scan Index Data = Exigts
Original Z-axiz Direction = Exizts
Mumber of Point Cloud Vertices = 39,324,310
Mumber of Extracted Planes = 478
Mumber of Extracted Cylinders = 79
Mumber of Extracted Reference Spheres =
Mumber of Extracted Checker Boards = 6
| tioe — [ blot Coint
Origin = (14340279127 m, 70306.70930 m, 001681 m) |
[l

Display Golor: (R:255, G146, B:38)
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5. Removing Noise

When scanning, unintended subjects such as human figures and other moving objects and
floating objects can be captured also. InfiPoints automatically detects and removes those points.

5.1. Removing Noise (Auto Recognize)

1. Select [Pre-process] tab > [Remove Noise] > [Remove Noise] ( ¥ ) from the ribbon menu.

) = |Smart Filter - FInfiPoints
Home Importl Pre-process |Ana|y5\s Maodeling Cutput Creation Recent

Prry 25 Define the origin i, Create Reference Point = | 4 Import External Reference Points ~ :Q:r."\+ R, Color/Intensity
- Mave Point Cloud ¢ Export . Register Two Groups © | & Extract Groind
Start — = Remove
Registration [ |- Fit to CAD / Polygon Model [ 2 Renumber Reference Points Moise = | Extract Pol
Register Reference Point % Remove Noise
Layer L | 5 Resume

o~ 1

2. "Remove Noise" dialog will appear. Switch the status of "On/Off" to On for each item of
"Noise types to remove" to specify the layer to which the noise is moved. At the same time,
an unused layer number is automatically assigned to the target layer.

Remove Moise =

Terminologies used in this dialog (PDF opens in 3 separate window

Moise types to remove (move to another layer)

On/Off Layer
Too close to the scanner [on | |3~
Too far from the scanner [on | [+ ]
Overlapping noise [on ] [5
Front noise [on | [~
Misxed pixel noise [on | |7
Floating noise [on | [~

[[]Expand advanced settings

Hide layers for noise points once completed

m Create new point doud exduding points in hidden and noise Setting
layers
Save Defaults Load Defaults Cancel

o The process will be skipped when a layer is not selected.

- Enable "Create new light point cloud data excluding points in invisible and noise layers"
to create a new filtered point cloud data without hidden layers and noise layers.

- Enable "Hide layers for noise points once completed" to hide the layer that was specified
as the target to store noise after removing noise.
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ﬁ Remove Noise function is only available with point cloud imported
from FLS (FWS), ZFS and PTX.

3. When clicking [OK], a confirmation dialog will appear.

Confirmation 4

This process will consume approximately 5 GB of disk space for temporary files, and take approximately
0.5 hourlz). {t could take longer depending on the environment.JWould you like to continue?

Cancel

Alarge temporary file is created with the noise reduction process. A rough
estimate of the disk memory would be shown, so please make sure that the
' designated [Work] folder has enough memory capacity.

How to check the [Work] folder: [Application Menu] > [Option] > [System
Preference] > [Path] > [WorKk]

4. By clicking [OK] in the confirmation dialog, noise reduction will start.

Progress of noise reduction can be confirmed on the progress bar in the dialog. Also, you
can click [Cancel] to pause the process.

Remowve Moise X

Remaving noise... 30% completed

Cancel

Please note that the following dialog will appear during the interruption
process of noise reduction. Click [Yes] to save the Work folder. By opening
the Work folder with [Resume] ( S ), you can resume noise reduction
from where you left off.

InfiPoints
‘Would you like to keep the Work folder to resume the noise
reduction process later on?
Ch\Usersh \AppDatatLocal\Temp \ELYSIUM\InfiPoints\den

oise_20220820_192000_0

* Please refer to 5.2, “Resuming Noise Reduction” for details about
resuming noise reduction.
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5. Once the noise reduction finishes, point cloud data classified as noise will be moved to
specified layers.
If the option "Hide layers for noise points once completed" is enabled in "Remove Noise"
dialog, the layer specified as noise will be hidden.

ID  Name Mo. of.. Cc™
[410 Generl () -
1 Hoise (-} -
42 Ground () -
[0z Too close to the scanner -) -

[0 4 Too far from the scanner -) -
[15 o0Overlapping noise () -
[1& Front noise -} -
[17 Mixed pixel noise -) -
[J& Floating noise -} -

| %IE] <) - »
< >
Show/Hide | vhiL | | v |
Selectable | AL | | o |
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5.2. Resuming Noise Reduction

1. Select [Pre-process] tab > [Remove Noise] > [Resume] ( S ) from the ribbon menu.

| ¥ |Smart Filter = | EnfiPoints
Home Impart Analysis Modeling Output Creation Recent

;'r"-'\' '5',‘& Define the origin = | iy Create Reference Point = "-‘; Impaort External Reference Points =
- - Move Point Cloud T TR e e g
Regis:;rattion 71 Fit to CAD / Polygon Model /% Renumber Reference Points
Register Reference Point
Layer L~ |

i |

Resume

2. The following dialog will appear. Specify the folder which you saved during the last
interruption of noise reduction (a folder whose name begins with "denoise"), and then click

[Select Folder].

T <« ELYSIUM » InfiPoints v O

Organize v New folder

MName

@ Select the Work folder (folder with prefix "denoise") of last interruption

2 Search InfiPoints

Date modified

#F Quick access
denoise_20221221_203045_0

o Onelrive ELY_TMP_FOLDBRTT184

[ This PC

¥ Network

€

I 12/21/2022 830 PM  File folder

12/19/2022 %:06 PM  File folder

= @

Type

Folder: | denoise_20221221_203045_0

Select Folder Cancel

Noise reduction will resume from where it left off.

Remowve Moise

Remaving noise... 30% completed

Cancel

If you try to resume noise reduction when the display state (show / hide) of

the point cloud part is different from the display state when noise

reduction was interrupted, the following dialog will appear. If this dialog
appears, adjust the display state of the point cloud part to the one when

InfiPoints

| There exists no point cloud data to waork on.

*
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noise reduction was interrupted, and then resume noise reduction.
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5.3. Removing Noise (Manual Recognition)

1. Select [Pre-process] > [Layer] > [Enable Layer Edit] ( ’-E@ ) from the Ribbon menu.

— O x

Learn with Tutaorial - | ? -

e o -, % w
558 —_— ox

Background Point Cloud with Complement Enable JGenerate
Zpint Cloud >  Scan Index~  Point Cloud - Layer Edit§ Polygon
Optimize Layer

2. [Layer] panel is displayed in editing mode.
Set a layer number for [Target Layer] to specify a layer for moving the noise to.

Layer ﬂ
A |
D Name No. of... Co... Co... Pic.. ™

0  Generl - - - v

1 Noise = = - v

2 Ground - |- - v v
< >
Show/Hide Vit Vo

Selectable aLL the

How to select points
o

- |

ety

Target Layer

1 o~
Target Layer (Press Shift)
B

v | | b
L

Disable Layer Edit

Q For more details about operation of [Layer] panel, refer to [Layer Editing]
in [InfiPoints Operation Manual Vol.2. Data Utilization].

3. In [Layer] panel, press [Rectangle] ( {*} ) from "How to select points".

How to select points

©

&2-C- 3 B
Target Layer

Target Layer (Press Shift)

Disable Layer Edit X

v

4. Select [Ctrl] key and drag the mouse while clicking on the 3D View Window.
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If you leave the checkbox of [Target Layer] disabled, it will be hidden when
the point cloud moves to [Target Layer].

Layer % |
A |

Q D Name Mo, of... Co.. Co.. Pic.
10 General - - - v
[J1) Noise v
T2 Ground v o
< >
Show/Hide whe Vo
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5.4. [Reference] About Remove Noise

Noise Types

Remaove Noise

Moise types to remove (move to another layer)

Too dose to the scanner
Too far from the scanner
Overlapping noise

Front noise

Mixed pixel noise

Floating noise

®m Too Close / Too Far

Terminologies used in this dislog (PDF opens in a separate window

OnjOff

On

On

On

On

* Points outside the specified [Valid Distance] from the scanner

m Overlapping Noise

* Points overlapping across multiple shots

- When overlap is detected among thin objects such as walls, the [Overlap distance]

setting will be used to maintain thickness.

® Front Noise

 Points scanned accidentally such as moving cars and human figures

2 ELYSIUM © 2023 Elysium
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m Mixed Pixel Noise

* Points detected along edges of object such as stretched thread
(Often happens when scanning light angle is acute)

m Floating Noise

* Points such as dust which is isolated from other points

o Reduction takes place if the noise is more than the value set in the [threshold
number of points for floating objects].
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Parameter for Remove Noise

Expand advanced settings

Valid distance from scanner |D.5 | mo - | 30 | m
COwverlap distance 0.02 m
g;:;lap distance when scanned from both m
Valid luminance |D | = | 255 |
Mixed pixel noise detection Weak I Strong
Tlt:regtlwsold number of points for floating
obje

Hide layers for noise points once completed

lt;;e:ri;e new point doud exduding peints in hidden and noise Setting

Save Defaults Load Defaults Cancel

m Valid distance from scanner

This specifies the target area range for noise reduction on overlapping noise and front
noise. Points outside of "valid distance" range will be automatically moved to close /
distant layers if they were specified in the dialog.

m Overlap distance

This specifies the distance between points to recognize as "overlapped." When the
distance between points is shorter than the specified value, it will be recognized as
"overlapped." However, points from several shots taken from 2 opposite sides are not
recognized as "Overlapping noise." This allows the objects which thickness is less than
"Overlap distance" to keep their thickness as they are.

m Overlap distance when scanned from both sides

This also specifies the distance between points to recognize as "overlapped," but this is
used only on the shots taken from 2 opposite sides. This allows you to perform noise
reduction also on thin objects like papers or cloths and show them accurately.

m Valid luminance

In overlapping noise detection, points in the range of "Valid luminance" are evaluated
better than those out of the range.

m Mixed pixel noise detection
You can adjust the strength of "Mixed pixel noise detection" in 6 levels.

® Threshold number of points for floating objects
This value specifies upper limit of the number of points to recognize as Floating noise.

m Hide layers for noise points once completed
After removing the noise, the layer specified as noise will be hidden.
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m Create new point cloud excluding points on invisible and noise layers

You can create a new filtered point cloud data without hidden layers and noise layers.

Supplement: Adequate noise reduction parameters

Items

Valid distance from the
scanner

Overlap distance

Overlap distance when
scanned from both side

Valid luminance

Mixed pixel noise
detection

Threshold number of
points for floating
objects

2 ELYSIUM © 2023 Elysium

Adequate Parameters

Generally executed with the default value between 0.5m and 30m
Used for short/long distance filter tolerance.

€ If the maximum value is decreased, the number of noises
detected will decrease also, resulting a reduced process time. This
is because overlapping noise and front noise reduction is
processed within the valid distance of overlapping scans.

Generally executed with the default value of 20mm

€ If the registration tolerance is not sufficient, try with a larger
value (over 20mm).

(Valid luminance will be considered and a higher density value
will be applied)

Generally execute with the default value of 5Smm
A parameter used to remove either side of a thin objects’ point
cloud to avoid insufficient visibility.

Generally executed with the default value of 0-255
If there is an overlap of high and low luminance, overlapping
noise reduction keeps data within the valid luminance.

€ To remove bright overlapping noise such as that of fluorescent
light, slightly raise the maximum value of valid luminance.

Change the value depending on the mixed pixel noise amount

€ If there are thread noise around thin objects such as wires, set
the detection level at 4 or higher (maximum level if 6).

Change the value depending on the data

€ If the data is from a scanned factory or plant, 80-120 would be
sufficient. In the case of scanned data of outdoor or natural
setting, set the level between 10 and 50 to avoid removing
excessive floating noise.
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6. Extracting Planes and Pipes

6.1. Auto-extracting Planes and Pipes

Automatically extract planes and pipes from point cloud data. This allows automatic modeling

of equipment and pipes.

If you want to auto-extract planes and pipes from the point cloud without scan
index data, use [Create Point Cloud with Scan Index] ( _:,: ) to create the point

cloud with scan index data beforehand.

O

1. Select [Pre-process] tab > [Extract Primitive] > [Extract Planes and Pipes] ( _'3; ) from the

Ribbon menu.

- ?Infipoints

I Pre-process I Analysis Modeling Output Creation Recent

N Create Reference Point ~ :'“& Impart External Reference Points = rfn“v., !. 'Jo"\. A
e 3

Erprer i Regirer e =

. Remove - Extra
- Renumber Reference Points Moise '1 Text

odel ‘ A
Reference Point Filter

2. Select the desired point cloud group in [Tree (Overview)] panel.

)

—

Extract Planes
and Pipes

Extract Primitive

Tree
Overview Pipe Plane Structure Duct
=-1E Model

3. "Extract Planes and Pipes" dialog will appear. If the option "Re-extract planes and pipes" is
unchecked and [OK] is clicked, planes and pipes are extracted based on the settings used

when the data was import.

Extract Planes and Pipes

Do you want to extract planes and pipes?

[ ]re-extract planes and pipes

Iaximum outside diameter of cylinders to extract

2 m

Iinimum outside diameter of cylinders ko extract
a m

2 ELYSIUM © 2023 Elysium

Page 105 | 137



v

Elysium InfiPoints Operation Manual Vol.1. Data Pre-processing

Planes/pipes/spheres are automatically extracted during point cloud import
and save as internal information. Planes and pipes are created based on
the saved internal information.

- To re-extract with a different tolerance, enable [Re-extract planes and
pipesl.

o To classify the extracted planes by the area size, enable [Classify plane
groups by area size].

4. Automatically extracted planes and pipes will be displayed on the 3D View Window after

completion.

Tiee

Cwerview Pipe  Plare  Structure  Duct
A& Model
EAZ]) Scans
=643 Groupt
% 2015021741
i 2osaz17A-2
Eig 2ms0217a-3
[ 2ois0217A-4
s 2015021745
EAe% 20150217A-6
B 20150217A-7
M7 Extracted Planes
A0 Extracted Piping System

L |

MNo. of points  Color *
255,637,506 -
2,283,059 -

o Hame

General
MNoise

Ground -] -
Too close to the.. 752,613 -
Too far from the.. 135 -
Qverlapping noise 57,251,126 -
Front noise 1,619,486 -

Show/Hide Vs Ve

Selectable AL o

The following dialog will appear.

Extract planes and pipes

o Completed feature (plane/pipe) extraction.

Select the next process

— Delete unwanted piping elements with [Delete Excess
Element]
This will increase the work efficiency in the post processes,

— Finish

If you would like to delete extracted fine piping automatically, select "Delete unwanted
elements with [Delete Excess Element]". Otherwise, select "Finish".
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Please refer to "InfiPoints Operation Manual: Vol.3. Point Cloud Utilization

Modeling" > "Pipe Modeling" > "Deleting Pipes" > "Deleting All Excess Pipes"
for how to use [Delete Excess Elements].
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In case the planes or pipes are not displayed in the "3D View" window,
please double-check that [Show Planes] ( : —7) and [Show Piping Elements] (
[j ) are enabled at [Home] tab > [Display Status].

0 ~ Smart Filter = FInfiPoints
Home Import Pre-process Analysis Modeling
Pl (9 +@

Output Creal

Lk '

Fit  Change |, . :I e -@ - =
View - jl |l @ "
View Operation Display Status

Decrease the point cloud display density to more clearly visualize the
positional relation between the planes and point cloud data showing

simultaneously.
Either select [Reduce Point Density] ( ._ ) from the Ribbon menu or select
Q the appropriate value from the pull down (|2 - ) right beside it.
7InfiPoints
nalysis Modeling Dutput Creation Recent
<10 -1 @ @ -[38 - e 0d = B
e, I s |E|:'? '. ;f é \' Dig:::fon DimEedrj:iu
Display Status Display Method M

By selecting [Size-adjusted (Round)] ( ‘@ ), [Size-adjusted (Square] ( " ),
or [Size-adjusted (Cube)] ( ¥ ) as the Point Type, points close to the view

point are displayed as enlarged. Or by selecting [Size-fixed] ( ), all the
points are displayed the same size.

Q FInfiPoints

nalysis Modeling Qutput Creation Recent
[T} = 1
Y- T e | P PPy b = E&
| BRdl. Thd § & |E| Size-fixed dit
\¢| size-adjusted (Round) =
Display Status Display [t
%' Size-adjusted (Square]
1 = | :

y’ Size-adjusted [Cube)

"Extracted Planes" and "Extracted Piping System" are added to the group in [Tree
(Overview)] panel.
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Overview Pipe  Plane  Structure

Duct

=-lAE Model
EED Scans
- Groupt

- 2015021741
[ 2015021742
-7, 20150217A-3
-l 20150217444
[ 20150217A-5
[, 20150217446
20150217A-7

2
e
s

Extracted Planes

M [ Extracted Piping System

Extracted pipes are displayed in [Tree (Pipe)] panel.

Overviewy| Pipe lane  Structure

Duct

=01 5] Extracted Piping System
@E Piping Group: 0
E 1S, Piping Group:
@ &, Piping Group:
E 1T Piping Group :
@ 1S, Piping Group:
@ 1S, Piping Group:

[ Y B N

E 1§, Piping Group:

Extracted planes are displayed in [Tree (Plane)] panel.

Overview  Pipe | Plane  Btructure

Duct

=21 £ Extracted Planes
=103 Extracted Plane System
b0 00001 - 001 m2:

Please note that only if the option "Classify plane groups by area size" is
enabled in "Extract Planes and Pipes" dialog, the extracted planes are
classified by size as shown in the image above.
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6.2. [Reference] Creating Point Cloud Data with Scan
Index

Point cloud without scan index data can be used to generate a point cloud with scan index. The
point cloud data with scan index created by this function can now be used to automatically

-3

create the plane and piping elements with [Extract Planes and Pipes] ( .5).

Advantages of Creating Point Cloud with Scan Index

» Auto-extraction of planes and pipes is now possible. Point cloud with scan index was a
must before.

The point cloud data with scan index, which will be used by this
function, is assumed to have completed registration process beforehand.
Therefore, it is not suitable for auto-registration (by using plane) or noise

A removal.

Even if you perform [Detect Collision Mode] ( Jag ) on the point cloud
data with scan index data created by this function, the result may not be
appropriate due to the specification.

1. Select [Pre-process] tab > [Optimize] > [Create Point Cloud with Scan Index] ( _"rf ).

- a X

Learn with Tutorial ~ - 7o

.5—'_\:: '_": og o
° Y, ° >fl’r _..ﬂ ¢°° 2 % @
a® 998 g

Cptimize for  Backgrdundll | Point Cloud with|fComplement Enable Generate
Visualization= Point Cl@ud 4| Scan Index~ oint Cloud = | Layer Edit Polygon
% Create Layer

- Top View *» Decrease Resolution I L x |

2. "Create Point Cloud with Scan Index" dialog will appear. Press [Add (Define tentative origin
(s) by selecting a point)] (| ¥ |) at the bottom of the list.
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Create Point Cloud with Scan Index *
Mo x A Fi
(= m|E
Resolution

Please note that if you have multiple point cloud parts without scan index

0 data, the above dialog will appear when you select a point cloud part
without scan index or a group containing the point cloud part without scan
index on [Tree (Overview)] panel.

3. Pick a point you want to specify as a tentative origin (virtual scan point) on "3D View"
window, and click [Done] ( 0 ).

Tentative origin refers to "a hypothetical scanning origin where the scan
shots are assumed to be taken". This will become the origin of the point
cloud part with scan index data created after execution.

o It is recommended that a tentative origin be set in a position that has
been considered scanned by a stationary scanner. In that case, it is
Q recommended that you place as few tentative origins as possible and
make sure that there are no blind spots.

o If there are too many tentative origins, the data size will increase.
Conversely, if the tentative origins are too few, the number of points
that cannot be observed from the tentative origin will increase, leading
to a decrease in the number of points included in the created point
cloud.

4. In the list of "Create Point Cloud with Scan Index" dialog, the coordinate value of the
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tentative origin will appear.
In this case, without changing the settings for "Resolution" and "Effective range by distance
from tentative origin (scanner position)", click [OK].

Create Point Cloud with Scan Index

Mo * Y z

1 -0,348 -1.482 2.003

|| = | '-.-‘_-.'_ | Q '¢'

Resolution
Horizontal 4000 pixels
Vertical pixels

Effective range by distance from tentative origin (scanner position)

Point cloud with scan index data is created.
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Ok Cancel
Tree H

Cwerview  Pipe  Plane  Structure  Duct

=-1E Model
BD Scans
: 23 Groupt
=23 Point_cloud
LA Sample by Handy Scanner

B [ Point cloud with scan index added
L[58 peintcloudwithscanindex1.poc
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Please note when executing [Extract Plane and Pipe] ( 313:] ) including the
newly created point cloud data with scan index, you need to move them to
the target group of "Extracted Planes" and "Extracted Piping System".

Owerviem  Pipe  Plane  Structure  Duct Owverview  Pipe  Plane  Structure  Duct
2-I1E1 Model =18 Model

QED Scans EED Scans

-*D Group1l -5 Groupt

[ LSo7364_020 [y LS07364_020
5 LS07364_021 - [l LS0T364_021

LS07364 022 -1 LS07364 022
507364 023 -7l LS0T364 023
- [k, LS07364 024 [P LS07264 024
[ LSo7364 025 [ Ls07364_025

A 1507364 026 -l LS0T364_026
[, LS073e4 027
-3 Point_cloud

- @éé pointcloudwithscanindex 1.poc I
=¥ Point_cloud
Point cloud with scan index added L[k Sample_by_Handy_Scanner

s+, pointcloudwithscanindex1.poc
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7. Creating Optimal Point Cloud Data for
Drawing

Raw point cloud data produced by just scanning is not suitable for drawing because of some
reasons, such as the uneven density. Therefore, the view operation of InfiPoints may become
heavy.

In that case, create point cloud data optimized for visualization to lighten the view operation of
InfiPoints.

Preparations for Optimizing Point Cloud Data for Visualization

* Uncheck unnecessary scan shots for the filtered point cloud in [Tree (Overview)]
panel.

Tree a
Overview Pipe Plane Structure Duct

E-E Model
B[ Scans
-7 Group?

J s 2015021741
JEs% 201502174-2
s 2015021743
5% 2015021744
% 201502174-5
M 20150217476
1 2015021747
-7 Extracted Planes

» Uncheck unnecessary layers for the filtered point cloud in the [Layer] panel.

Layer x|
P |
D Mame No. of points €™
ol General 255,637,506 -
(11| Hoise 2,283,059 -
21 Ground - |-
[13]| Too close to the.. 752,613 -
(14| Too far from the.. 135 -
[1s| overapping noise 57,251,126 -
[d6 | Front noise 1,619,486 -
(17| Mixed pixel noise 1,642,820 -

[ 18] Floating noise 15,399,863 -
19 - -

There are two types of point cloud data optimized for drawing: "Background point cloud data"
and "Point cloud data optimized for visualization".
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7.1. Creating Background Point Cloud Data

Create a point cloud to be displayed as the background on "3D View" window.

Advantages of Using Background Point Cloud Data
* Enhance the drawing speed by optimizing the point cloud according to the drawing
method of InfiPoints.

 Enable displaying just enough information while keeping the project data size at
minimum by displaying the point cloud created in another project as the background
point cloud.

» Large scale point cloud data can be drawn efficiently.

Q For background point cloud data, it is possible to add dimensions, add
notes, and create reference points. Other functions are not available.

1. Select [Pre-process] tab > [Optimize] > [Background Point Cloud] > [Generate] ( <. ) from
the ribbon menu.

Learn with Tutorial ~ - ? -

AR

ckground |[Point Cloud with Complement Enable Generate
n pud - Scan Index~  Point Cloud = | Layer Edit Polygon

Optimizg for §| Ba
Visualizatyon - Poi

»  Generate Layer

2. "Generate Background Point Cloud" dialog will appear. In this case, click [OK] without
changing the default. Creation of background point cloud will start.

Generate Background Point Cloud x

Generating background point doud. ..

Click [OK] to continue.

Once completed, the project will be saved as a new
revision automatically.

Options

Hide normal point doud and show background paint
doud once completed

(Changeable anytime from [Home] tab = [Display
Status])
Advanced settings
[l a

Cancel

3. When the creation of background point cloud is completed, the following dialog will appear.
Click [OK].
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InfiPoints X

o Successfully generated background point cloud. [Revision: 20}

After creating the background point cloud, the revision is automatically
saved with the comment "Autosaved after generating background point
cloud".

4. Display on "3D View" window switches to show "Background Point Cloud Only", and all the
point clouds except the background point cloud are hidden. The created background point
cloud can be viewed in [Background Point Cloud] panel.

Background Point Cloud = |
& ax] [%
Show Mame Folder location

Revision 20 BackgroundPointCloud'20

< >

Showi/Hide WarL v

To switch the display of the background point cloud, press [Show Normal
Point Cloud Only] (| g& |) or [Show Background Point Cloud Only] (| 4 ) in
the upper left of [Background Point Cloud] panel.

Q You can also change from [Home] tab > [Display Status] icons.

[# = “: v Smart Filter * | FinfiPoints -
Home Import Pre-process Analysis Maodeling Output Crea
B) (9 m|s [=h -= o -6 -0 -5

Fit  Change 1)_, = || | E Show Background Point Cloud
View = ety
Hide Background Point Cloud

View Operation

The created background point cloud can be displayed as the background of another project.

Please note that the background point cloud data is stored inside the

ﬁ automatically created folders with revision numbers, which are located within
BackgroundPointCloud folder. BackgroundPointCloud folder is located within
the project folder.
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7.2. Importing Background Point Cloud Data

Display the background point cloud data created in another project on "3D View" window.

1. Select [Home] tab > [Show/Hide Panels] ( #— ) and display [Background Point Cloud] panel.

- O x

Learn with Tutarial - ﬁ =

Tree

Annotation L

Dimension

v
v
v | Layer
v
¥

Background Point Cloud

Top View

2. Press [Import Background Point Cloud] (| "4 ) at the upper right of [Background Point
Cloud] panel.

Background Point Cloud B
s]lm| (8] [%

Show MName Folder location ‘

3. "Import Background Point Cloud" dialog will appear. Click [Browse].

Import Background Peint Cloud X

Spedfy the background point doud to import by the folder path.

Background point coud folder |

OK Cancel

4. "Select Folder" dialog will appear. Specify a folder for the background point cloud data, and
then click [Select Folder].
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@ Select Folder x
<« v o <« Mac... » BackgroundPointCloud v O 2 Search Backgroun...
Organize v New folder Sl 0
MName Type
7 Quick access
15 File folder
@ OneDrive 19 File folder
E This PC 20 File folder
[? Metwark
< >
Folder: | 19 |
| Select Folder | | Cancel |

5. You will return to "Import Background Point Cloud" dialog. Click [OK].

Import Background Point Cloud >

Specify the backaround point doud to import by the folder path.

Background peint cdoud folder 1\Machine_Room'BadkgroundPointCloudi13 | Browse

Cara

)
]

6. In [Background Point Cloud] panel, press [Show Background Point Cloud Only] (| .as ).
Background point cloud will appear on "3D View" window.

Background Point Cloud % |
Show MName Folder location
oy \ il
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7.3. Creating Point Cloud Data Optimized for
Visualization

Advantages of Optimizing Point Cloud Data for Visualization

* Data size can be reduced by eliminating unnecessary point clouds.

* Enhance the drawing speed by optimizing the point cloud according to the drawing
method of InfiPoints.

Please note that because the filtered point cloud data do not include any
scan index data, some functions such as [Regist Auto ("Register using

A detected planes")], [Remove Noise], and [Extract Planes and Pipes]
cannot be used. Depending on the function you want to use, it may be
necessary to switch between the original point cloud and the optimized
point cloud.

In this case, to create a lighter data size of point cloud compared to the original point cloud,
create point cloud data optimized for visualization by thinning out points.

1. Select [Pre-process] tab > [Optimize] > [Optimize for Visualization] > [Create] ( “>. ) from the
ribbon menu.

Pre-process Analysis Madeling Output Creation Recent Learn with ©
;1.::"& M Color/Intensity Filter c*J.—] EE A% Edit :'"E:\,e_o ign:;’:: ”
) Lr_“_ =" ) & R '
Remave Extract Planes Create Edit Optimize for Complement
Moise “I Extract Pole and Pipes - Colar Wisualization Point Cloud ~
Filter Extract Primitive Texture Point Cloud Colar Optimize

2. "Optimize for Visualization" dialog will appear. Specify the settings and click [OK].
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Optimize for Visualization x

Optimization methods

Resolution 5 mm

[+]Reduce the data size by sampling
[]Place points at equal intervals

[Jrefine visualization by interpalation using scan index data

Layer 9
[Jremove aberrant points in distance
Remove points outside Clipping Box (Available anly when Clipping Box is active)

Structure of result point doud

(") Maintain the current structure, and optimize per point doud file

(®) Merge into a single point doud file

(_IMerge, and then divide by XY-plane grid

Gtid size 10 i

COptions after optimization
[JHide the original point doud

[Jsave the result as a new project

Cancel

In general, the following setting is recommended.

o Specify "Resolution" from Optimization methods to place points at equal intervals.
o Check "Reduce the data size by sampling" from Optimization methods.

o Select "Merge into a single point cloud file" from "Structure of result point cloud".

Q Refer to InfiPoints Help > [Functional Description] > [Pre-process] >
[Optimize] > [Optimize for Visualization] for more details about option.

- Please note that when "Reduce the data size by sampling" from
Optimization methods is checked, thin out so only one point per
O interval will remain as specified in "Resolution".

o All target scan shots will be merged into a single point cloud when the

"Merge into a single point cloud file" option is selected in "Structure of
result point cloud".
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It is also possible to create filtered point cloud from the point cloud
enclosed within the Clipping Box. The procedure is as follows.

1. Enable [Clipping] panel and enclose only the target point cloud with
Clipping Box on "3D View" window.

. . efc £ 3

2. In [Clipping] panel, check the option "Hide points outside Clipping Box"
to display only the point cloud enclosed within the Clipping Box.

Clipping x|
Show only the points within Clip Box I
Show Box [ |5ection Mode
Highlight points @ Side
O Top

3. Select [Optimize for Visualization] (";':\__.). In "Optimize for Visualization"

dialog, check the option "Remove points outside Clipping Box" and click
[OK].

Optimize for Visualization

Optimization methods

Resolution mm

Reduce the data size by sampling
[ Place points at equal intervals
[ refine visualization by interpolation using scan index data

Layer 9

[CIRemove aberrant points in distance

I Remave points outside Clipping Box (Available only when Clipping Box is active) I
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Please note that when "Also save the result as a new project” is checked,
another project or viewer file can be created at the same time as creating

point cloud data optimized for visualization.

Save option

I Alzo save the result as a new project I

Save as:

Qutput Folder

[ visible elements only
Optimized points only {Exdude original points)

Export target

3. Filtered scan shot (Filtered_points) will be created.

Successfully created 1 of point cloud elements.
Filtered_points
The criginal point clouds remains in the file, so hide them (check off in
[Structure (Tree)] panel) to view newly-created light point cloud data
only.

InfiPoints X

Tree H

Overview Pipe Plane Structure Duct

=-FE Model

E|[:| Scans

53 Groupt

[ 201502174-1
-, 201502174-2
[l 201502174-3
-[i 2015021744
-t 201502174-5
- 20150217A-6
-, 2015021747
-[A7 Extracted Planes
[/ Extracted Piping System

.3;3,32 Filtered_points |

To automatically hide the original point cloud when creating the point
cloud optimized for visualization (Filtered_points), enable "Hide the
original point cloud" and execute.

2 ELYSIUM © 2023 Elysium

Options after optimization
Hide the original point doud

[]save the result as a new project
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8. Managing Project Data

8.1. Saving Projects

InfiPoints stores the editing history as revisions, and the revision number increases as you save
it.

1. Select [Application Menu] > [Save With Comment] ( H ).

-| Y (A %W 4 ~[smart Filter - FlnfiPoints -

T
‘ New H Quick Save

L x Clean up Project
.
g Print... »

% Option 4

E3 Exit
2. Save With Comment dialog will appear.
Enter the comment for the new revision and click [Save].
Save with Comment x
Revision comment:
% Cancel
Q Click [Quick Save] ( H ) to save a new revision without a comment.

Click [Save with Comment] ( H ) to save a new revision including all
elements. In this case, the modeling elements are also saved when saving the
revision. If there are many modeling elements, it may take time to save.

When merging projects including modeling elements by [Project File] ( "—‘ ), it
is necessary to save revisions using this function. Otherwise, the function [Save
with Comment] ( H ) is recommended to save the revision.

‘ Please note that once a revision is saved, it cannot be overwritten.
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Autosave Project

In "System Preferences" dialog, enable "Autosave" option from [Miscellaneous] tab to
automatically save revisions with the interval you have set. Autosave will run even if the
project on the network share folder is opened.

- £ 003 - smart Filter - EInfiPoints

Y
| New ﬂ% System Preference..,
[T = 3
|| ] Open Project... :—"\@ Display Preference...
B s System Preferences b4
I]'d Save. LNk £y Im|
Path Beap [+ Use
= ) Quick Access Toolbar Sel Color Opaciy
9 Clean up Project @ gl BackGround Color m L
Axis PreSelection - Opacity [ ]
\
H Frint... 4 Ground plane [ Blement Name
Ruler/Grid [ Element Information
{S@ Option ) en Cermer HighSpeed Temp DrawMads Cow
View aperation HighSpeedFront Select Mode Siow (] Quick
View operation(Z)
CAD/Pelygen Model Select & point of point clouds [ Snap precssely to point cloud
i Select drawing element [ Snap to dimensions
IMimllaneuubls Reduce ficker duing point cloud deplay  [FON
Puirt Cloud Fie [+ Add information for shader rendering automatically
Length urits m ~
Number of used threads '2 ]
Use functions under development COon
Enabled Unda A0N
—
Autosave EAon
) Save every 2| minute(s)
| Cancel sony
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Unload Point Cloud with Scan Index

This is a function to exclude the point cloud with scan index from being loaded into
memory when a project is opened. Collision detection data, etc. created from the point
cloud with scan index will continue to be read into memory.

By unloading the point cloud with scan index before exporting, you can reduce the data
size of the new project.

B Steps:

1. Select [Pre-process] tab > [Point Cloud with Scan Index] > [Unload] ( ‘i_, ).

— O X
Learn with Tutorial ~ 0 =

® @

Enable Generate
Layer Edit Palygon

Layer

- Se ssgg
o \:u [ _}r L) ) .’
it Optimize for  Background}||Point Cloud with fCorjplement
Visualization~ Point Cloud Sean Index - oirg Cloud ~

Opl =% Create

L |

“. Decrease Resoltion

—% Load

£, Unload

5

Point cloud with scan index is unloaded. Unloaded point cloud parts are grayed out on
[Tree (Overview)] panel.

Tree B Tree n
Overview Pipe Plane Structure Duct Oveniew Pipe Plane Structure Duct
B--E Model B--E Model

BD Scans BD Scans
=] 5.7 Groupt

L507364_021
L507264_022
LS07264_023
L507364_024
L507264_025

=107 Groupt =-

vl LS07364_020
NA:# Ls07364 021
A LS07364 022
M Ls07364 023
MA# 1507364 024
NAs 1507364 025

L507264_026 N Lso73s4 026
A% LS07364_027 Mlii LS07364_027
-] Extracted Planes -.[v|F Extracted Planes
[ Extracted Piping System 1 Extracted Piping System
-[1:% Filtered_points % Filtered_points

Please note that you can reload the unloaded point cloud with scan
index with [Point Cloud with Scan Index] > [Load] ( =%).

@

You cannot load point cloud with scan index from a project that was
exported excluding the point cloud with scan index.
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8.2. Opening Projects

1. Select [Application Menu] > [Open Project] ( j ).

-| ) “t = |Smart Filter - EinfiPoints -

[ i File Used Rec
Newd il ently

1 Sample_Project

| !_;’_",-' Open Project...

H Save... 3

Clean up Project

2. Open Project File dialog will be displayed.
Specify the project folder in the left pane of the dialog. The list of Revisions will be displayed
in the right pane of the dialog.

Open Project File X
Select a project folder. Select a revision,
| C:\ InfiPaints\002 Rev. Graph Date Created Comments
P | L e
Music 2/13/2018 1:00: EXPOr rn..lng
=] Pictures 15 ¢ 11/23/2018 12:27:43 PM createj maovie
m Videos 12 11/28/2018 12:25:14PM modeling duct and stran
_|;| Floppy Disk Drive (A:) 3 = 6/1/2018 1:18:48 PM top_dencise.ifpraj
-4 Local Disk (C:) 2 6 5/1/2018 12:26:01PM top_5_merge_pipe_pla
! &[] _nfiroints 10 6/1/2018 12:25:59 PM top.ifproj
1 00
]
£ > £ >
. COpen Cancel
L &
Save Path
Q Right-click on a revision to edit its comment, to delete that revision, etc.
from the context menu.
Open Project File *
Select a project folder. Select a revision.
| C:\_InfiPaints'002 Rev. Graph Date Created Comments
= Downioads " 0 2{14/2018 2:21:19 PM Autosaved 1'|r deanup
13 1 Edit Comment drawing
15 1 movie
12 1 Delete Revision g duct and stra
3 [ noise.ifproj
2 e £ Property merge_pipe_pla
10 /12018 12:25:53 PM top.ifproj

3. Specify a Revision from the list and click [Open].
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Open Project File »
Select a project folder. Select a revision,
| C:\UnfiPoints'002 | Rewv. Graph Date Created Comments
-- Downloads A 3 002 17 P
- ) Music = : -
&3] Pictures 010 12:27-
i Videos 12 112302018 12:25:14 PM modeling duct and stra
H Floppy Disk Drive (A:) 3 6/1/20018 1:18:48 PM top_denuise.ifproj
Local Disk (C) 2 8 6/1/2018 12:26:01PM top_5_merge_pipe_pla
_InfiPoints 10 6/1/2018 12:25:59 PM top.ifproj
@ 001
002
Q) 003
o4
Qo5
B v
< > < >
o e
Save Path

Please note that when a revision of a project on the network drive is
specified, the following dialog will appear. A project on the network drive
can directly be opened. However, there may be a delay when trying to
display drawings. It is recommended to select "Copy to local Project folder
first, and then open the copied one" to open a project.

' InfiPoints X

The file is located in a network folder.

(") Open the file in a network folder.

® Copy to local "Project” folder first, and then open the copied one.
(Approximate file size: 3029MB)

| OK | | Cancel

Selected Revision will open.

B 055 § v Semart Fiter +|  BinfiPoints - De¥infPoints - o %
Home | Impet  Preprotess  Anabsi  Modeing  Outpid Crestio  Recent Learm wan Tutaral = B

B (Pe@EEcon-sle g0 ==~ |= £k & £
" gmrio] (@-elaiols B 4@ oo o o, e 2 g | e
e e -

Teee B SR
Jz
Oherview Ppe  Plane Struchwe Duct
= EIE Model 3
FAD sans
B30 Groupr
B 2015021781
Bl misizira-2
B 2015021742
Fgg 2015021784
B zosaz1ra-s
B 2msazimace
g mmsaia-v
Az Extracted Planes
AR Extracted Piping Syster

B tame Mo, of... E...
Eo  Geneml 140,5... -
1 nose 1,721 -

Ground ..
3  Toodesetothe 592,172 -
B4 Toofa fromthe 10,07... -
E5  Ovebppng nos  39,54... -

6  Front nose 1087.. - ¥

<

Show/Hde Vau e

Selectabie Ba o

Ready status
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8.3. Cleaning up Project Data

This is a command to reduce the data size of the project folder by deleting unnecessary
Revisions and/or files.

1. Select [Application Menu] > [Clean up Project] (" "¢ ).

-l ©y ~ Smart Filter ~  EInfiPoints - C:\Elysium®IrfiPoints_da

Mo File Used Recent
Hew i ently

1 Sample_Project
| Open Project...

H Save.. »
[

L K Clean up Project

A confirmation dialog will appear.

InfiPoints

To perform cleanup, the current state of the project will be
saved as a new revision with a comment “Autosaved for
cleanup”.

* Clean-up is a process to delete files that are no longer in
use, and requires the information on the current state of the
project.

' This dialog will only appear when the project needs to be updated.

2. Click [Yes] in the dialog to save the Revision in the state before executing the clean up.

Clean up Project Data

Updating project data... {4/ 5)

3. Once the autosave is completed, "Clean up Project Data" dialog will appear.
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Clean up Project Data X
Total size of this project: 16,54 GB
Total size of files that are not used in currently-opened revision (shown in pink in the list below): 155.99 MB
Select revision(s), and then dick [Check for Unused Files] to list up all files that are used in the selected revision(s) only.
Revision list:
Del Revision Graph Date created Comment Size Cu... "
O 10 10/11/2018 1:59:38 AM  Autosaved for deanup 5.21MB
O 9 10/11/2018 1:56:17 AM  08_20_drawing 5.21MB
O 7 10/11/2015 1:48:48 AM  07_duct_modeling 5.21MB
O [ 10/11/2018 1:47:38 AM  06_pipe_modeling 5.21MB
O 5 10/11/2018 1:43:57 AM  05_motion 5.21MB
O 4 10/11/2018 12:21:15 04_extract_planes_pipes 5.21MB
O 3 9/24/2018 10:55:22PM 03 _remove_noise 5.21ME v
Check for Unused Files
File list:
Del Path Extension Description Usedin... Date created Size ™
CadModelthito.enf .enf CAD model No 9/17/2018 10:39:30 PM 585.87 KB
CadModel\Sample 1. fig flg CAD model No 9/17/2018 10:39:30 PM 475.92 KB
CadModel\sample14.fig Mg CAD model Mo 9/17/2018 10:3%:31PM 133,15 KB
CadModel\sample 16.enf .enf CAD model Mo 9/17/2018 10:39:32PM 127.72 KB
CadModel\Sample17.fig fig CAD model Mo 9172018 10:3%:32 PM 133.15KB
CadModel\Created_Plane_Group2.fig fig CAD model Mo 9172018 10:3%:30 PM 2.59 KB
CadModel\Sample. fig fig CAD model Mo 9172018 10:3%:30 PM 475.92 KB
CadModel\Sample 1.enf .enf CAD model Mo 9172018 10:3%:30 PM 127.92 KB
CadModel\Sample 10.enf .enf CAD model No 9/17/2018 10:39:30 PM 127.81KB
CadModel\Sample12.fig flg CAD model No 9/17/2018 10:39:30 PM 133.15 KB
CadModel\Sample13.enf .enf CAD model No 9/17/2018 10:39:30 FM 127.73KB v
Total size of files to delete: 73.76 MB
Cancel

About the "Clean up Project Data" dialog

o In the "Clean up Project Data" dialog, "Revision list" is displayed in the upper part,

and "File list" is displayed in the lower part.

o Files that are not referenced by any Revision are initially checked on.

o Files referenced only by currently opened Revision are not displayed in the "File

list."

o "Total size of files to delete" at the lower right of the dialog will be updated when

the check box is checked/checked off.

4, Check Revision(s) to delete in the "Revision list."

Clean up Project Data

Total size of this project: 16.54 GB
Total size of files that are not used in currently-opened revision (shown in pink in the list be

Select revision(s), and then didk [Chedk for Unused Files] to list up all files that are used in

Revision list:
Delete Revision  Graph Date created Comment
| 10 10112018 1:59:38 AM  Autosaved for deanup
| 10/11/2018 1:56:17 AM  08_2D_drawing

9

7 10112018 1:48:48 AM  07_duct_modeling
3 10/11/2018 1:47:33 AM  06_pipe_modeling
5
4

5

S

10/11/2018 1:4%57 &AM 05_motion
10/11f2018 12:21:15 04 _extract_planes_pipes
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o Selecting any Revision in the "Revision list" highlights the files
referenced by the selected Revision in the "File list" by yellow.

Revision list:

Del Revision Size Currentlyopened
0 5.21M8

0 T 5.21M8

0 ? 5.21M8

[m] 10/13/2018 1:43:57 AM 5.21M8

[m] ¢ | 10/11/2018 12:21:15 am 04_extract_planes_pipes 5.21M8

[m] ¥ 9/24/2013 10:55:22PM 03_remove_noise 5.21M8

[N] 2/18/2018 5:32:33PM 02_registration_auto 5.20M8 v

| Check for Unused Fies

File list:
Path Extension  Description Usedin,.. Date created Size A
PointCloud\KXMEP3 184332_9680_20 Point cloud Ne 9/20/2018 12:52:48 AM 64.00 k8
PointCloudKXVEP2453000_9580_70 Point coud o 9/20/2018 12:40:36 AM 64,00 KB
PointCloud KXMEP33386 12_9580_14 Point cloud No 9.59 M8
CadValidation |Extracted Planes_b34ed181-Oce7-4188-26b-3c1065d. . .txt CAD validation  Ves(Ca... :39: 32348
CadValidation |Exiracted Flanes_b34ed181-5ce7-4188-526b-3c1065d. . .txt CAD validation  Ves(Ca... 9/17/2018 10:33:43PM 3.08M8
Drawing\Cylinderfxis. dwg fig Drawing Ho 9/17/2018 10:33:43PM  83.33KB
Drawing\CylinderAxis 1.dwg fig Drawing Ne 9/17/2018 10:39:43 PM 88,88 KB
Drawing\CylinderAxis2.dwg «dng Drawing o 9/17/2018 10:39:44PM 95,10 KB
Drawing\drawing L dwa «dwg Drawing No 9/17/2018 10:39:44PM 1L.86KB
Drawing'drawing 10.dwg dng Drawing No 9/17/2018 10:39:44PM 1L75KB
Drawing\drawing 11.dwg dng Drawing Ho 5/17/2013 10:35:44PM 97168 v

o Selecting any file in the "File list" highlights the Revisions referenced by
the selected file in the "Revision list" by green.

Revision list:
Del Revision  Graph Date created Comment Size Cumently opened
]
[m} 10/11/2018 1:56:17 AM 08_2D_drawing
O 10/11/2018 1:48:48 AM 07_duct_modeing
[m] 10/11/2018 1:47:38 AM 06_pipe_modeing
O
]
] v

Check for Unused Files

path Extension Desciption Usedin... Date created sze ~

PointCloudiKXMEP3184332_9680_20226 0 Point doud 9/20/2018 1215248 A 64.00KB

PointCloudiKXMEP2453000_9680_7061_0 Point doud 9/20/2018 12:40:36 AM

PointCloudMEP3338612_9680_14457_0 Paint doud 5/20/2018 12:55:22 AM
cAl

to 5/17/2018 1 MB
Draning\Cylinder Axis.dwg dug Draning 9/17/2018 10:33:43PM  93.38KB
Drawing\Cylinder Axis L.dwg .dwg Drawing 9/17/2018 10:39:43 PM 83.88K8

Drawing\Cylinder Axis2. dwg .dwg Drawing 9/17/2018 10:39:44PM 95.10KB
Drawing\drawing L.dwg .dwg Drawing 9/17/2018 10:39:44PM 11.85KB
Drawing'\drawing 10.dwg .dwg Drawing 9/17/2018 10:39:44PM 1L75KB
Draningdrawing 11.dng dwg Drawing 9/17/2018 10:33:44PM 9.71K8 v

5. By clicking [Check for Unused Files], the check box of the files referenced only by the
Revisions whose check boxes are turned On in the "Revision list" will be On.

5.21MB
2 5.20 MB v

Check for Unused Files

Extension Description Usedin... Date created Size ™
.poc Point doud Mo 9/20/2018 12:55:08 AM 9.68 MB
.poc_la Point doud No 9/20/2018 12:55:08 AM 9.70KB

6. Click [OK] to delete Revisions and files that are checked in the revision and file lists.

.dwg Drawing No 9/17/2018 10:39:44 PM 11.33KB
dwg Drawing Mo 9/17/2018 10:3%:44PM 11,40 KB
.dwg Drawing Mo 9/17/2018 10:39:44PM 11.36 KB
.dwg Drawing No 9/17/2018 10:39:44 PM 1286 KB W
Total size of files to delete: 73.76 MB
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8.4. Merging Project Data

Multiple project data can be merged into one project data.
For example, you can gather the project data that were worked on separately, and merge all the
project data into one after the work is completed.

This command can merge the following:

* Point Cloud
0 * Reference point

* Modeling elements (Planes / Pipes / Structures / Ducts) ... InfiPoints version
6.0 or later

9 Please note that when merging the projects including modeling elements,
specify the project which is exported by [Save with Comment] ( H ).

1. Select [Import] tab > [Data Import] > [Merge Project Files] ( ‘—1 ) from the Ribbon menu.

|4 % %+ Smart Filter | FInfiPoints

Hame Import Pre-process Analysis
-‘E 1‘_\ - . <3 Merge Project Files
¥y By N

Point CAD Polygon 2D/3D
Cloud Model Model Drawing

Data Import

2. "Import" dialog will appear. Specify the project file (Top.ifprojx) to import, and click [Open].

@ Import X
&« v A <« |P_DATA » ExportProject A v O Search ExportProject_A 2
Organize « MNew folder ==~ [H o
MName Date modified Type Size 2
# Quick access )
Layoutimage File folder
@ OneDrive Log File folder
Maotion File folder
1 This PC - )
= PointCloud File folder
|_ﬂv Metwaork PaintCloudimage File folder
Revision File folder
Scene File folder
Symbol File folder
J Top.ifprojx IFPROJX File 20KB
< >
File name: |Top.ifprojx V| Ifprojx file(*.ifprojx) ~

Ca n ce'
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Please note that you cannot specify a particular revision. Elements
included in the last opened revision will be imported.
' If you want to import a particular revision, it is recommended to prepare
another project in advance from [Output Creation] tab > [Project File] ( I"

).

3. A "Confirmation" dialog will appear. Click [OK].

Ceonfirmation 4

Do you wish to merge point cloud data in "ifprojx” file into
currenthy-opened project file?

Gance

When importing a project created with versions before InfiPoints 6.0, the
modeling elements will not be imported.

InfiPoints >

Please note that planes and piping/structure/duct elements
! created in former versions are not supported.

Click [OK] to continue as is, or [Cancel] to save the project in
this version to include those elements and try again.

Cancel

i

When specifying a project file (Top.ifprojx) which does not include
modeling elements, the following dialog will appear.

InfiPoints >

Please note that this project does not contain any modeling
! elements [planes and piping/structure/duct elements).

Click [CK] to continue as is, or [Cancel] to save the project with
[Save with Comment [All)] and try again.

Frotl

Specified project will be imported.
Each element of the currently opened project and another imported project is divided into

separate groups.

- Image of a merged project
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ﬁ n ~[Smart Filter = SinfiPoints - D:¥IP_DATA¥MachineRoom_1 (Revision: 35) - u]

Home Import Pre-process Analysis Modeling  Output Creat  Recent Learn with Tutorial ~ = [

14] -}:‘ ‘ ¥H % Merge Projedt Files

Point CAD Polygon 2D/3D
Cloud Maodel Maodel Drawing

Data Import

Tree L~ | 7
Oveniew Pipe Plane Structure Duct
=-E Model
=BT Scans
-3 Groupd

M3 Original peint cloud
Filtered_points
-7 Extracted Planes
- 1@ Extracted Piping System
-G Structure

8P Duct System
- 1db Equipment0l
=0 Work area A
-1 Extracted Piping System
35 Structure

A Duct Svstem
-~ Work area B

[ Extracted Piping System
-7 Structure
-[1E) Duct System

Tree | Annotation | Dimension

Ready status

Please note that the display status for modeling elements is not

reflected when imported. All modeling elements will be displayed
A regardless of the original display status when imported.

It is recommended to delete unnecessary modeling elements before

importing.

Please note that when editing the modeling elements after merging the
projects, the following dialog may appear.

(Example) When Plane Modeling

InfiPoints *

| Select planefs) that belong to the same “Extracted Planes”

0

This is because the groups of modeling elements to edit are different.
Copy each modeling element to the same part at once (Extracted Planes/
Extracted Piping System/Structure/Duct System) and then edit the
modeling element.

Please refer to [Plane Modeling], [Pipe Modeling], [Structure Modeling],
and [Duct Modeling] in "InfiPoints Operation Manual Vol.3 Point Cloud
Utilization Modeling" for more details about how to copy planes, pipes,
structures, and ducts.
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» Workflow when dividing and working on a project (Example)

Workflow before Work Allotment

1. Import 2. Start 3. Remove 4. Extract
Point Cloud Registration Noise Planes & Pipes

6. Optimize 7. Mark the 8. Export as
for Divided Areas Another
Visualization (Optional) Project

5. Define
Coordinates

* Place markers in the areas to be assigned Exclude the original point cloud when
- Use "Drawing" or "Scene” funtions exporting to reduce the data size and
—_—— o ) shorten the data transfer time
1 I
|a e |
-If- — Ty
|
e —

9. Copy
Project to
Each Working
Computer

Workflow Performed by Each Computer

3. Copy
2. Export Project back
Project File to the Original
Computer

1. Modeling

Generate models in the - Export only the modeling elements
assigned area

- "Delete" unnecessary modeling
elements instead of "Hide"

Workflow for Merging Project

1. Merge

Project Files

Merge the divided project back into Delete the duplicated modeling
the original project elements
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8.5. Reducing the Data Size of Point Cloud with Scan
Index

While retaining the scan index, the data size can be reduced by lowering the density point
cloud.

1. Select [Pre-process] tab > [Point Cloud with Scan Index] > [Decrease Resolution] ( ﬁ‘ﬂ}n ).

— O X

Learn with Tutorial ~ - ? -

s alx LY @
e S —
Optimize for  Backgroundl|Point Cloud with §Comilement Enable Generate
Visualization~ Point Cloud 4| Scan Index ointiCloud = | Layer Edit Polygon
Opl “% Create Layer

I I' -

2. In [Tree (Overview)] panel, specify the group that includes the point cloud with scan index
which you wish to reduce the size.

Tree H
Crverview  Pipe Plane Structure Duct

=& Model

B .

- LsoT3ea_o23
[ LS07364 024
5 LS07364 025

-
.[]77 Extracted Planes
f] ] Extracted Piping System

If the specified group contains point clouds without scan index, those
0 without are excluded from the process. When decreasing the resolution of
the point clouds, those without scan index within the group will be ignored.

3. "Decrease Resolution of Point Cloud with Scan Index" dialog will appear. In this case, select
the resolution as "1/2 (No. of points to 1/4)" and click [OK].
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Decrease Resclution of Point Cloud with Scan Index

Decrease the resolution to;
(®) 1/2 (Mo. of points to 1/4)
() 1/4 (Mo. of points to 1/18)
() 1/8 (Mo. of points to 1/54)

oK Cancel

The process of decreasing the resolution of point cloud with scan index will start. Progress

status can be seen in the progress bar.

Decrease Resolution of Point Cloud with Scan Index *
Decreasing resolution of point doud with scan index. .. 60% completed

Cancel

When the process is completed, a newly decreased resolution point cloud with scan index

data is created.

Tree H
Owerview Pipe  Plane  Structure  Duct

- =15 [Model

E||:| Scans

w577 Groupt

B [ Resolution decreased
-8 LS07364_020
-5 LS07364_021
-1 LSo7364 022
- LS07364 023
[ LsoT364_024

- [ LsoT364_025
[, LSo7384_026
-, LS07364 027
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In this case, the resolution is reduced by 1/2 in both the height and width
directions, so the number of points in the new decreased resolution point
cloud (lower right figure) is reduced to approximately 1/4 compared to the
number of points in the source point cloud (lower left figure).

Property [ | Property x|
[ Coordinate system (World coordinate svstem) ] [ Coordinate system (World coordinate svstem) ]
Group [Grroup ﬁl Group [Rezolution decreazed

Mumber of Point Cloud Groups: Mumber of Point Gloud Groups:
with Scan Index Data = 8 with Scan Ihdex Data = 8
without Scan Index Data =0 without Socan Indes Data = 0
Mumber of Point Gloud Wertices = 3357295498 Mumber of Point Glouwd Yertices = 83,950,571
Mumbet of Extracted Planes = 7,192 Mumbet of Extracted Planes = 0
Mumber of Extracted Cylinders = 3817 Mumber of Extracted Cylinders = 0
Mumber of Extracted Reference Spherez = 0 Mumber of Extracted Reference Spherez = 0
Mumber of Extracted Checker Boards = 0 Mumber of Extracted Checker Boards = 0
Mumber of CAD Madelz = 0 Mumber of CAD Maodelz = 0
Mumber of Reference Points = 0 Mumber of Reference Points = 0
L4 > L4 >

When you want to reduce the data size of your project, it is recommended
to output it as a separate project with only the decreased resolution of
point cloud with scan index displayed.

Please refer to [Exporting Files] > [Exporting Projects] of "InfiPoints
Operation Manual: Vol.2 Point Cloud Utilization Simulation & Data
Utilization" for details about exporting projects.
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All rights reserved by Elysium or the original author of this material. The content may not
be edited, reproduced, distributed, transmitted, displayed, published, broadcast, sold or
lent without the prior permission of the author.
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